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While Deltek has attempted to verify that the information in this document is accurate and 
complete, some typographical or technical errors may exist.  The recipient of this document is 

solely responsible for all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is 
subject to change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are 
reserved. No part of this document may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, or translated into another language, without the prior written 

consent of Deltek, Inc. 

This edition published December 2017. 

© Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and 
proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related 
documentation, is provided for use only in accordance with the terms of the license agreement. 

Unauthorized reproduction or distribution of the program or any portion thereof could result in 
severe civil or criminal penalties. 

All trademarks are the property of their respective owners. 
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Deployment Options 

The Deltek Costpoint 7.1 Architecture allows for very flexible and scalable deployment options to 
meet the specific needs of your business. These options include, but are not limited to, multi -
tenancy, optional components, authentication models, database options, load balancing and fail -

over configurations, co-deployments with Budgeting & Planning and/or Time & Expense, access 
controls, and many other important features to consider.  

Careful consideration of your deployment is an extremely important step in your planning 

process. Deltek has provided many resources to assist you in your deployment planning and 
implementation process and strongly recommends you leverage these resources in order to plan 
a smooth implementation of your Deltek deployment. 

We strongly recommend starting with the document titled 
DeltekCostpoint711DeploymentOptionsTechnicalOverview.pdf, available in Deltek Software 
Management (DSM). The documents listed in the Related Documentation section include 

numerous important documents for you to consider as part of your planning and implementation 
process. 

Time & Expense 10.0 requires you to carefully consider and choose a deployment option along 

with your Costpoint instance. You now have the following options:  

 Share Everything — Robust model where Costpoint and Time & Expense are deployed 
as one system (one product, one menu), allowing you to leverage your hardware and 

operational investment 

 

Deltek recommends you use this option, which is required for some current and future 
enhancements (for example, you must use this option if you plan to utilize 
Subcontractor Management capability). 

 Share Infrastructure — Only share WebLogic deployment 

 Share Nothing — Stand-alone deployment 

Subcontractor (SubK) Management Users 

If you choose to leverage the new Subcontractor Management add-on, you must deploy and 
configure the Share Everything deployment model, where Costpoint and Time & Expense are co-

deployed as a single system. 

 



Upgrade Installation Checklist 

 

Upgrade Installation Guide for Microsoft SQL Server® 2 

 

Upgrade Installation Checklist 

The following is a checklist of the overall steps needed to install Time And Expense 10.0.0. 
Details for each step are provided on subsequent pages.  

Print this checklist and use it as you complete this installation, if desired. 

Done? Step Notes 

 

Step summary… Any pertinent notes… 

Pre-Installation 

 1. Costpoint 7.1.1 must be installed and operational.  

 2. All Costpoint 7.1.1 Hot Fixes must be installed.  

 3. Check Time And Expense 9.0.1 Transaction 
Database Pre-Upgrade Status. 

 

 4. Back up Time And Expense 9.0.1 Schemas.  

Database Tier Installation 

 1. Upgrade Time And Expense 9.0.1 Database using 
Time And Expense 10.0.0 Database Tier Installer. 

 

 2. Enable JDBC Distributed Transactions.  

Application Tier Installation  

 1. Install Time And Expense 10.0.0 Application Tier 
Software. 

 

 2. Configure Time And Expense 10.0.0 Access.  

 3. Reinstall Time And Expense 10.0.0 Windows 
Service. 

 

 4. Reconfigure Time And Expense 10.0.0 Windows 
Service. 

 

Web Tier Installation (Microsoft IIS) 

 1. Install Time And Expense 10.0.0 Web Tier 

Software. 
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Done? Step Notes 

Using Time And Expense 10.0.0 

 1. Set Web Browser Internet Options.  

 2. Log in to Time And Expense 10.0.0.  

Collation Conversion 

 1. Convert Time And Expense 10.0.0 

database(s)/schema(s) to Latin1_General_BIN 
collation. 

 

Post-Installation 

 1. Install latest Time And Expense 10.0.0 hot fixes.  

Related Documentation 

The following table lists the additional documentation that downloads along with this release. 
Except where noted, all the user guides and quick reference guides listed in this table are also 
available for download from the Deltek Customer Care Connect site. 

You will need Adobe Reader 8.0 or later to view the documents listed in this section. 

Release Notes 

Document Name Description 

Deltek Time And Expense 10.0 Database 

Changes 

This document describes the database 

changes between the release of Time And 
Expense 9.0.1 and Time And Expense 
10.0.0. 

Deltek Time And Expense 10.0 Release 
Notes 

Major New Features — Click this bookmark 
to view the major new features included in 

Time And Expense 10.0.0. 

Enhancements — Click this bookmark to 
view the enhancements included in Time And 

Expense 10.0.0. 

Known Issues — Click this bookmark to 
view the known issues that are part of the 

current release of Time And Expense 10.0.0. 
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Entity Relationship Diagrams (ERDs) 

Document Name Description 

DeltekTimeAndExpense1000TransactionSchemaERD.zip This ZIP file contains the ERD 

for the Deltek Time And Expense 
10.0.0 Transaction schema. Use 
index.htm to view the ERD. 

Other Documents 

Document Name Description 

Deltek Costpoint Interface Getting Started 

Guide 

This document describes instructions for 

accessing Time And Expense’s applications 
as well as descriptions of menus, toolbars, 
and other global features. You will also find 

information on logging on to Time And 
Expense, accessing the database, printing 
reports, reviewing online help, and contacting 

Deltek Customer Care and other client 
services. 

Deltek Time And Expense 10.0.0 Menu 
Mapping 10.0.0 to 9.0.1 

This document describes how the menu 
selections inside Time And Expense 10.0.0 
map back to Time And Expense 9.0.1. 

Deltek Time And Expense 10.0.0 Menu 
Mapping 9.0.1 to 10.0.0 

This document describes how the menu 
selections inside Time And Expense 9.0.1 

map to Time And Expense 10.0.0. 

Deltek Costpoint Interface User Interface 

QRC 

This document is a quick reference card 

which can be kept handy and used for 
reference as you navigate Time And 
Expense 10.0.0. It describes how to navigate 

through the application. 

Deltek Costpoint Interface Shortcut Keys 

Toolbar Icons And Buttons QRC 

This document is a quick reference card 

which can be kept handy and used for 
reference as you work in Time And Expense 
10.0.0. It lists the shortcut keys available in 

Time And Expense, as well as the toolbar 
icons and buttons. 

Deltek Costpoint Interface Views QRC This document is a quick reference card 
which can be kept handy and used for 
reference as you work with the Time And 

Expense 10.0.0. It explains the differences 
between Table View and Form View. 



Upgrade Installation Checklist 

 

Upgrade Installation Guide for Microsoft SQL Server® 5 

 

Document Name Description 

Deltek Costpoint Interface Query and Lookup 
QRC 

This document is a quick reference card 
which can be kept handy and used for 

reference as you work with the Time And 
Expense 10.0.0.  It explains how to use the 
query and lookup functions in Time And 

Expense. 

Deltek Costpoint Interface Setting Up 

Printers QRC 

This document is a quick reference card 

which can be kept handy and used for 
reference as you work with the Time And 
Expense 10.0.0.  It explains how to set up 

printers. 
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Upgrade Installation Overview 

This document provides instructions for installing the Deltek Time And Expense 10.0.0 software. 
During the installation process, you will perform the following: 

 Ensure that your system meets the installation prerequisites. 

 

Please refer to the Installation Prerequisites and System Requirements sections for 
additional information. Also please review the full list of Related Documentation prior to 
installing or upgrading to Time And Expense 10.0.0. 

 Execute the Time And Expense 10.0.0 Database Tier installer to upgrade your Time And 
Expense 9.0.1 database. 

 Install the Time And Expense 10.0.0 Application Tier software. 

 Configure Time And Expense 10.0.0 access. 

 Install the Time And Expense 10.0.0 Web Tier software to your Internet Information 
Server, if applicable. 

 

If you need help with this installation, please contact Time And Expense Technical Support at 
877.HLP.PROJ (877-457-7765). 

Installation Package Contents 

The Time And Expense 10.0.0 installation package contains the following: 

 Time And Expense 10.0.0 Database Tier installer 

 Time And Expense 10.0.0 Application Tier installer 

 Time And Expense 10.0.0 Web Tier installer 

 Deltek Time And Expense 10.0.0 Upgrade Installation Guide for Microsoft SQL Server 

Installation Prerequisites 

The following prerequisites must be met before upgrading to Time And Expense 10.0.0: 

 Your Time And Expense databases must be at version 9.0.1 (GA). 

 DeltekTimeandExpense901HotFixBundle008.exe must be installed. 

 Hot fixes up to and including TE901B8HF65.zip (Patch 276) must be installed. 

 

You can use the following query on you Time And Expense 9.0.1 database to see which 

database patches have been applied, SELECT * FROM TC_000X.TC_TABLE_VERS . 

 You must have Administrative access to your Time and Expense 9.0.1 Transaction 
database. 

Database Tier Installation Prerequisites 

Before you start the Database Tier installation process, your database server must meet the 
following software prerequisites: 
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Prerequisite 

Component 

Details 

Software All product compatibility information is maintained in the Deltek 

Product Support Compatibility Matrix available on the Customer 
Care Support Site here. 

Please note the database compatibility levels: SQL Server 2016 

(130), SQL Server 2014 (120), and SQL Server 2012 (110). 

Passwords To run the installation, a password is required for Microsoft SQL 

Server SA user or any user with “sysadmin” privileges. 

Firewall Settings On your Database Server, the Microsoft SQL Server Instance Port 

(that is, 1433) must be open for Inbound and Outbound traffic 
through your firewall. 

For a Named Microsoft SQL Server Instance, the following must be 

met: 

 A dedicated port should be configured for the instance and 
such a port should be open for Inbound and Outbound traffic . 

 SQL Browser Service must be enabled and running. 

 SQL Browser UDP Port (that is, 1434) should be open for 
Inbound and Outbound traffic. 

On your Database Server, make sure that Network discovery and 
file sharing options are switched on. 

SQL Server The Time And Expense 10.0.0 database user needs the following 
permissions granted: 

 Create Function 

 Create Procedure 

 Create Table 

 Create View 

Close all software applications running on the desktop. 

To avoid memory contention, check the memory allocated for SQL Server and make sure the 

server can allocate at least a minimum of 3 GB. 

Application Tier Installation Prerequisites 

Before you start the Application Tier installation process, the application server that will run your 

Time And Expense 10.0.0 software must meet the following prerequisites: 

Prerequisite 

Component 

Details 

Software All product compatibility information is maintained in the Deltek 

Product Support Compatibility Matrix available on the Customer 
Care Support Site here. 

https://deltek.custhelp.com/app/answers/detail/a_id/38499
https://deltek.custhelp.com/app/answers/detail/a_id/38499
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Prerequisite 

Component 

Details 

Costpoint 7.1.1 must be installed and operational. 

All Costpoint 7.1.1 Hot Fixes must be applied. 

Time And Expense 10.0.0 Server Startup Prerequisites 

Before you start Time And Expense 10.0.0, the following must be met: 

Prerequisite 

Component 

Details 

Server 

 

Database firewall requirements should be configured. 

On your Application Server, the WebLogic Listener Port 7009 
must be open for Inbound and Outbound traffic through your 
firewall. 

On your Application Server, make sure that the Network 
Discovery and File Sharing options are switched on. 

Time And Expense 10.0.0 Initial Log In Configuration Prerequisites 

Before you can login to Time And Expense 10.0.0 your Windows client computer must meet the 
following requirements: 

Prerequisite 
Component 

Details 

Software 

 

All product compatibility information is maintained in the Deltek 
Product Support Compatibility Matrix available on the Customer 

Care Support Site here. 

Adobe Reader 8.0 or later. This is only required for users who 
want to print Time And Expense 10.0.0 reports in PDF format. 

Make sure that you select the Display PDF in browser option 
under the Preference settings for Adobe Acrobat Reader to avoid 
pulling up a blank IE screen when printing in PDF format. 

Web Tier Installation/Microsoft Internet Information Server (IIS) 
Configuration Prerequisites 

The Web server that will host your Internet Information Server software must meet the following 
prerequisites: 

Prerequisite 
Component 

Details 

Software 

 

All product compatibility information is maintained in the Deltek 
Product Support Compatibility Matrix available on the Customer 

Care Support Site here. 

Microsoft Internet Information Server 7.0 

https://deltek.custhelp.com/app/answers/detail/a_id/38499
https://deltek.custhelp.com/app/answers/detail/a_id/38499
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Installation Process for Time And Expense 10.0.0 

The Time And Expense 10.0.0 installation process incorporates the following steps:  

Component Change Details 

Database Tier 
Installation 

The Database Tier installer automatically upgrades the following 
schemas: 

 Transaction Schema (that is, TC_0001) 

The Database Tier installer automatically performs all the 
following actions: 

 Restarting the Distributed Transaction Coordinator(MSDTC) 

Service (if applicable) 

 Upgrading Time And Expense 9.0.1 Database 

 Upgrading Time And Expense SYSTEM Database (if 

applicable) 

 Provides the option to migrate your Time And Expense 9.0.1 
Security settings to Time And Expense 10.0.0 

Application Tier 
Installation 

The Application Tier installer automatically performs all the 
following actions: 

 Applying Cleanup_CP_Apps Scripts (if applicable) 

 Applying Menu_data Scripts 

 Applying TC.const Scripts 

 Applying TC.msg Scripts 

 Applying TEESS_Modules Scripts 

 Applying TM.msg Scripts 

 Applying UDT_Templates_Data Scripts 

 Applying UDT_TERMS Scripts 

 Applying TE Metadata Scripts  

Web Tier Installation The Web Tier installer automatically performs all of following 
actions: 

 Extracting HelpFiles 

 Resetting Internet Information Server 

Web Servers Supported In Time And Expense 10.0.0 

The Time And Expense 10.0.0 system supports the following Web servers only: 

 Microsoft Internet Information Server 

 Oracle’s WebLogic Web server 
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Naming Conventions 

The naming conventions specified in this section are used in all installation instructions detailed in 

this upgrade installation guide. 

Drive Letters 

The table below lists the drive letters used in the installation instructions. 

Drive Description 

C: The drive where the Time And Expense 10.0.0 software is installed. 

Directory Names 

The table below lists the directory names used in the installation instructions. 

Directory Name Description 

ORACLE/MIDDLEWARE12.1.3 The name of the directory where the Oracle WebLogic 

software is installed. 

DELTEK The name of the directory where the Costpoint 7.1.1 and 

Time And Expense 10.0.0 software is installed. 

Database Names 

The table below lists the database names used in the installation instructions . Clients are free to 
choose the database name. 

Database Name Description 

DELTEKTE The name of your Time And Expense 10.0.0 database. This database 

includes the Transaction schema and objects. 

Internet Information 

Software installations, installation instructions, technical guides, and release notes are available 
for download from the Deltek Software Manager (DSM). All future releases of Time And Expense 
10.0.0 are also downloaded from DSM. 

DSM is the sole download source for hotfix files. Deltek Knowledge Base articles provide an 
explanation of the fixes and contain links to DSM for retrieval of the actual files. 

Deltek Software Manager Requirements 

You can run DSM from any desktop. It does not need run from Deltek application servers. 

In order to run DSM, you must meet the following requirements: 

 Windows XP or later 

 Microsoft .NET Framework 3.5 SP1 (3.5.1) 
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The following Deltek Knowledge Base article contains a download link to the framework. It also 
has examples of what you may see if you do not have the framework installed: 

https://deltek.custhelp.com/app/answers/detail/a_id/52469 

 

Refer to the DeltekSoftwareManager.pdf to learn more about DSM and how it works. 

DSM Documentation and Troubleshooting 

 To view the online help for Deltek Software Manager, click here. 

 To view a tutorial on how to use Deltek Software Manager, click here.  

 To view more information on troubleshooting Deltek Software Manager, click here. 

 

The above troubleshooting link will only work if you are logged into Deltek Customer Care 

Connect. 

Knowledge Base Documentation 

To view Knowledge Base articles, complete the following steps: 

1. Go to http://www.deltek.com and click Support Login. 

2. Enter your logon credentials in the following fields and click Log In: 

Field Name Description 

Username Your Support user name 

Password Your Support user password 

If you have forgotten your username or password, click Account Assistance.  

 If you have forgotten your username, enter your email address and click Email My 

Username.  

 If you have forgotten your password, enter your username and click Reset My 
Password. 

3. On the Deltek Support Home Screen, click the Knowledge Center tab, and complete the 
following fields: 

Field Name Description 

Refine by Product Select Time And Expense from the drop-down list. 

Refine by 
Category/Version 

Expand Service Pack / Hot Fix from the drop-down list and 
select 10.0.0. 

Search Type Use the default value, Phrases, or select your preferred search 
type from the drop-down list. 

https://deltek.custhelp.com/app/answers/detail/a_id/52469
https://dsm.deltek.com/DeltekSoftwareManager/Help/
https://dsm.deltek.com/DeltekSoftwareManager/Tutorial/PubData/Engine/Default.htm?https%3A%2F%2Fdsm.deltek.com%2FDeltekSoftwareManager%2FTutorial%2FPubData%2F
https://deltek.custhelp.com/app/answers/detail/a_id/52469
http://www.deltek.com/
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Field Name Description 

Search by Keyword Enter the specific text you are looking for or leave blank to 
return all records for this version. 

4. Click Search. 

5. On the search results screen, perform the following actions: 

a. In the Summary column, click the link for the desired correction. 

b. When the desired correction loads, click the links in the Answers section to 
download the files. 

System Requirements 
The Time And Expense 10.0.0 system uses the following components: 

 Database Tier – SQL Server 

 Application Tier – With integrated WebLogic Server 

 Browser Client – Internet Explorer, Chrome, Firefox, Safari 

 Web Tier – Microsoft Internet Information Server (optional) 

 All product compatibility information is maintained in the Deltek Product Support 
Compatibility Matrix available on the Customer Care Support site here. 

 

For the Time And Expense system to function properly, the system clocks on your WebLogic 
application server and the database server that hosts your Time And Expense databases must 
be synchronized with each other. Failure to synchronize your system clocks may result in login 
and other system problems. 

 

A hardware recommendations document should have previously been distributed to you. For 
future releases of Time And Expense, hardware recommendations will be supplied via a 
Customer Care Knowledge Base article. 

For the most current hardware and software requirements, please refer to the Knowledge Base 
article containing the Compatibility Matrix: 

https://deltek.custhelp.com/app/answers/detail/a_id/38499 

https://deltek.custhelp.com/ci/fattach/get/1072689/0/filename/DeltekProductSupportCompatibility
Matrix.pdf 

Time And Expense 10.0.0 Log File Information 

The table below provides information on the log files used by the Time And Expense 10.0.0 
system. All of these log files are located on the Application Server under the 

C:\Deltek\Costpoint\71\logs folder. 

https://deltek.custhelp.com/app/answers/detail/a_id/38499
https://deltek.custhelp.com/app/answers/detail/a_id/38499
https://deltek.custhelp.com/ci/fattach/get/1072689/0/filename/DeltekProductSupportCompatibilityMatrix.pdf
https://deltek.custhelp.com/ci/fattach/get/1072689/0/filename/DeltekProductSupportCompatibilityMatrix.pdf
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File Name Description 

DEServer.log This log file is maintained by the WebLogic server instance. 
In a clustered environment, each server will write to a 

separate file and the file name matches the server name. 
The log records server-specific events such as the startup 
and shutdown of servers, the deployment of new 

applications, or the failure of one or more subsystems. The 
messages include information about the time and date of 
the event as well as the ID of the user who initiated the 

event. 

CP_DBConn_DEServer.log This file lists the activate connections used by the product 

at given time. To enable this logging, set 
<SYSTEMNAME>.logDBConnectionProfile = true in 
enterprise properties. In a clustered environment, each 

server will write to a separate log file and the name of the 
server will determine the name of the log file. 
CP_DBConn_<Server>.log 

CP_DEServer.log This log file contains application-specific information such 
as performance, security, and errors encountered while 

running a Costpoint application. Each server will write to a 
separate log file and the name of the server will determine 
the name of the log file. CP_<Server>.log. 

CP_Security_DEServer.log This file captures messages generated by the Costpoint 
Web security module. Messages such as invalid login 

attempt due to user id, password, insufficient parameters, 
and deactivated user account are captured here. In a 
clustered environment each server will write to a separate 

log file and name the server will determine the name of the 
log file. CP_Security_<Server>.log. 

delteke.log This log file contains information that pertains to the entire 
domain. It consolidates log records from all application logs 
and a subset of events recorded in all server logs. All the 

information gathered is written into a single file. 

Note: Not all log messages are written into domain. Only 
those messages that match the defined severity are 

consolidated. 
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File Name Description 

service.log This log file contains messages generated by the Costpoint 
Web windows service. It helps in troubleshooting issues 

related to service startup, which usually occur during the 
initial configuration stages. In addition to service-related 
messages, it also contains most of the information that is 

captured in the DEServer.log. So, once the initial startup 
issues are sorted out, it is suggested to disable this log by 
editing the InstallCPWebasService.cmd 

(C:\Deltek\Costpoint\71\bin folder), removing the 
occurrence of "-log:%CP_ROOT%\logs\service.log". If 
you remove this after installing the service, you will need to 

uninstall and reinstall the service for the changes to take 
effect. 
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Pre-Installation Instructions 

This section provides instructions to prepare your Time And Expense 9.0.1 system for upgrade to 
Time And Expense 10.0.0. 

 

Please ensure that you perform the steps in this section before performing any test upgrade and 

again before you upgrade your production environment. Changes made to your production 

environment after you have upgraded your test copy could provide different results for the pre -

validation section. 

During the pre-installation steps, you will perform the following actions: 

 Install and configure Costpoint 7.1.1. 

 Apply latest Costpoint 7.1.1 hot fixes. 

 Create a backup of your Time and Expense 9.0.1 database(s).  

 Shut down the Time and Expense 9.0.1 application service before starting database 
upgrade and close any outstanding database connections to the database. 

 

As part of upgrading Time and Expense, Deltek strongly recommends performing an 

update to the database collation for Time and Expense to binary collation. The 

Collation Conversion Tool will set the collation of your Microsoft SQL Server Time and 

Expense database(s) to “Latin1_General_BIN”. This setting is binary case sensitive, 

and may have an impact on customer specific programs, reports, data imports, and 

other applications which interact with Time and Expense and/or the underlying Time 

and Expense database. These applications and programs may need to be modified 

and need to be re-tested as part of your Time and Expense 10.0.0 upgrade. The 

conversion process is a separate process after completion of Time and Expense 

upgrade and it is required that all domains are upgraded before converting the 

database to binary collation. 

For example: 

 If custom scripts or stored procedures exist where the table and field names 

are in lower or mixed case, the scripts and stored procedures will need to be 

modified so that they match the object case sensitivity, which is always upper 

case for Time and Expense tables. 

 If end user queries refer to account names in lower case, and the account 

names are actually in mixed case or uppercase, the queries will need to be 

adjusted so that they use the same case as the account names. 

 If reports or data import programs interact with Costpoint, they may need to be 

adjusted and re-tested as well. 

MS SQL Server Clients upgrading from Time And Expense 9.0.1 with US-English Collation 
should run the collation analysis option as part of the pre-validation steps. Please read the 
Collation Conversion section for instructions on running the utility. 

Install and Configure Costpoint 7.1.1 

Time And Expense 10.0.0 runs on the Costpoint 7.1.1 framework. So before you can install Time 

And Expense 10.0.0, you must install Costpoint 7.1.1. 
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If you do not already have a functioning Costpoint 7.1.1 environment, follow the appropriate 
installation document to install Costpoint 7.1.1: 

 DeltekCostpoint711NewInstallationForMicrosoftSQLServer.pdf 

 DeltekCostpoint711UpgradeInstallationForMicrosoftSQLServer.pdf 

Once you have a functioning Costpoint 7.1.1 environment, accomplish the next step below, Apply 

Latest Costpoint 7.1.1 Hot Fixes. 

Apply Latest Costpoint 7.1.1 Hot Fixes 

Time And Expense 10.0.0 requires all Costpoint 7.1.1 hot fixes to be applied prior to installing 

Time And Expense 10.0.0. 

Once you have a functioning Costpoint 7.1.1 environment, follow the appropriate installation 
document to install the latest Costpoint 7.1.1 framework update and all downloaded hot fixes: 

 DeltekCostpoint711FrameworkUpdateInstallation.pdf 

 DeltekCostpoint711DeployingHotFixes.pdf 

 

Costpoint 7.1.1 Framework Update MUST be installed BEFORE installing Costpoint 7.1.1 Hot 

Fixes. Costpoint 7.1.1 Hot Fixes MUST be installed BEFORE installing Time And Expense 

10.0.0. 

Once you have the latest Costpoint 7.1.1 framework update installer loaded and have appl ied all 
Costpoint 7.1.1 hot fixes, return to the next step below, Notify All Time and Expense Users. 

Notify All Time and Expense 9.0.1 Users 

It is important that you coordinate the timing for the upgrade with all Time and Expense 9.0.1 
users. Users must not access the Time And Expense 9.0.1 database during the upgrade. 

Back Up Time and Expense 9.0.1 - Back Up Time and Expense 
9.0.1 Schemas 

Deltek strongly recommends you take a backup of your existing Time and Expense 9.0.1 
database before you upgrade to Time And Expense 10.0.0. 

Customers may use their own preferred way to create a backup of the Time and Expense 9.0.1 
database. 

 

Deltek strongly recommends that you regularly test and verify your database backups . 
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Database Tier Installation 

This section provides instructions and recommendations for upgrading your Time And Expense 
9.0.1 database to Time And Expense 10.0.0. 

During this installation process, you will install the Time And Expense 10.0.0 Database Tier 

software to upgrade your Time And Expense 9.0.1 database schema(s) to Time And Expense 
10.0.0. The Time And Expense 10.0.0 database will be referred to as a Transaction database 
schema where transactional data will be stored. 

 

The Time And Expense Database Tier installer creates a SQL Server database user and 
corresponding schema with the same name. 

Before You Start 

Make sure that you meet all Database Tier Installation Prerequisites. 

Install Database Tier Software 

The steps to install the Time And Expense 10.0.0 Database Tier software as well as create the 

Transaction database are detailed in this section. 

You must perform this step on your database server. 

 

For SQL Server cluster installations, the install directory must be a local drive as opposed to a 
shared drive. 

You must have Internet access on the machine where the Time And Expense 10.0.0 installer is 
invoked in order to automatically download the latest 
DeltekTimeAndExpense1000DatabaseUpgradeFiles.exe and Deltek 

TimeAndExpense1000RequirementsINI.exe files automatically. The 
DeltekTimeAndExpense1000DatabaseUpgradeFiles.exe contains the latest database patch 
rollback scripts as well as the latest list of Time And Expense 9.0.1 database patches that have 

been worked into the upgrade. The TimeAndExpense1000RequirementsINI.exe contains the 
latest OS platforms and database versions supported. These files are automatically downloaded 
when you launch the Database Tier installation, assuming that your database server has Internet 

access.  

 

The Deltek product installers contain functionality which enables them to dynamically download 

configuration files and patch rollback scripts when the product installers are executed from the 

Deltek Software Manager server.  To improve security, these connections have been modified to 

require communication over HTTPS. 

If your database server does not have Internet access, you will need to perform the steps in the 
Latest Upgrade Files Download section of this document before you run the 

DeltekTimeAndExpense1000DatabaseTier.exe file. 

To install the Database Tier software, complete the following steps: 

1. Run the DeltekTimeAndExpense1000DatabaseTier.exe file to launch the Time And 

Expense 10.0.0 Database Tier installation program. The Welcome to the Time And 
Expense 10 Installer screen displays. 
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Due to enhanced security in Microsoft Windows Server 2012, it is advised that you use 
the Run as Administrator option when launching installation files, even if you are 
logged in as a user with local administrative rights . To Run as Administrator, right-
click the installer file in Windows Explorer and select Run as Administrator. 

2. Click Next >. 

3. On the License Agreement screen, review the license agreement, select the I accept the 

terms of the license agreement check box, and click Next >.  

4. On the Choose Time And Expense Database Scripts Directory screen, click Browse to 
navigate to an installation location for the Time And Expense 10.0.0 Database Tier 

software. The default installation location is C:\Program Files\Deltek\Time And 
Expense\10.0.0 (recommended). Click Next >.  

5. On the Select Deltek Time And Expense Install Type screen, select Upgrade from TE 

9.0.1 and click Next >. 

6. On the Select Database Platform screen, select Microsoft SQL Server and click Next >.  

7. On the Deltek Time And Expense 10.0.0 Transaction SQL Server Database Information 

screen, complete the following: 

 

For the Time and Expense upgrade, the installer requires system adm inistration information of 

the Time and Expense 9.0.1 admin schema (TC_0000) in order to list all Time And Expense 

9.0.1 Company Domains that are candidates for upgrade. This initial screen will be presented for 

the user to enter system information about the admin schema (TC_0000). 

 

Field Name Action 

IP Address or 

Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 

example, dbsvr01) of your Time And Expense 9.0.1 database 
server. The default value is your computer name. 

The values for the IP Address or Hostname cannot be 127.0.1.0.1 

or localhost. 

For SQL Cluster installations, you must specify the SQL Cluster IP 
Address or SQL Cluster Hostname. 

Port Enter the SQL Server TCP port of the database server instance. 
The default port for SQL Server is 1433. 

Currently, this installer will allow database installations to connect 
to a SQL Server DEFAULT instance over port 1433 only. Use of 
non-default ports will be addressed in a future release. 

Database Name Enter the name of your Time And Expense 9.0.1 database. The 
default value is DELTEKTE.  In addition to standard alphanumeric 

characters, the following special characters are also supported:  

# $ - _ .  

Instance Name Enter the name of your database instance. The default value is 
LOCAL.  In addition to standard alphanumeric characters, the 
following special characters are also supported: 
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Field Name Action 

$ - _  

SA User Name Enter the name of your Microsoft SQL Server SA user. The default 
is sa.  If a user with “sysadmin” privileges is available, that user 
can alternatively be used.  In addition to standard alphanumeric 

characters, the following special characters are also supported:  

$ - _  

SA User 
Password 

Enter the password for your Microsoft SQL Server SA or 
“sysadmin” user account.  In addition to standard alphanumeric 
characters, the following special characters are also supported:  

‘ ~ # $ ^ & ( ) - _ + = , . 

8. Click Test Connection. If you entered the proper database connection information, a 

message similar to the following displays: 

 “Connection Successful. Click Next.” 

If the message above does not display, correct the connection information and click Test 

Connection again.  

9. After the “Connection Successful. Click Next.” message displays, click Next >. 

10.  On the Select Time And Expense System screen, select the Time And Expense 9.0.1 

Company Domain that you want to upgrade to Time And Expense 10.0.0 and click Next 
>. 

 

The Select Time And Expense System screen is presented with all Time And Expense 9.0.1 

Company Domains that are yet to be upgraded to Time And Expense 10.0.0. 

Please note, only current Time And Expense 9.0.1 domains are listed on this screen 

selection and only one domain can be upgraded at a given time. You will have to run this 

installer again for each Company Domain that you want to upgrade to Time And Expense 

10.0.0. 

11.  On the Deltek Time And Expense 10.0.0 Transaction SQL Server Database Information 

screen, complete the following: 

Field Name Action 

User Name The Time And Expense 9.0.1 Master Domain user name, that is, 
TC_0000, will display. 

Password Enter the password for your Time And Expense 9.0.1 Master 
Domain (TC_0000).  In addition to standard alphanumeric 

characters, the following special characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

User Name Your selected Time And Expense 9.0.1 Company Domain user 
name, that is, TC_0001, will display.  
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Field Name Action 

Password Enter the password for your selected Time And Expense 9.0.1 
Company Domain.  In addition to standard alphanumeric 

characters, the following special characters are also supported:  

‘ ~ # $ ^ & ( ) - _ + = , . 

12.  Click Test Connection. If you entered the proper database connection information, a 
message similar to the following displays: 

 “TC_0001 schema will be upgraded. Click Next.” 

If the message above does not display, correct the connection information and click Test 
Connection again.  

13.  After the “TC_0001 schema will be upgraded. Click Next.” message displays, click 

Next >. 

14.  The following message displays: 

 

The Deltek Time And Expense 10.0.0 Database Tier installer has been enhanced to 

enable the ability to convert various settings when upgrading from Time & Expense 
9.0.1.  If you select Yes, you will be prompted if you would like to convert security settings 
after selecting the domain to be upgraded to Deltek Time And Expense 10.0.0.  

 

Please note that you should only choose to do this against your primary TE 9.0.1 domain, 

unless, you choose a unique ADMIN schema for the additional domains. 

When choosing to migrate security settings, the following items will be migrated over to 
your TE 10.0 configuration: 

 LDAP IP.  For clients who use LDAP as an authentication method, the employee 
LDAP ID will be converted to the Costpoint security model during this process. 

 Security Groups.  TE 9.0.1 security groups will be modified and converted to 

security groups in the Costpoint security model during this process.  

 UDT Labels.  TE 9.0.1 UDT Labels will be converted to the Time And Expense 
10.0.0 configuration for all configured languages. 

 

Please review the Deltek Time And Expense 10.0.0 Post Configuration Guide for 

additional information regarding this conversion process. 
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15.  If you do not wish to migrate and configure Deltek Time And Expense 10.0.0 security 
settings, select No and proceed to item# 19. 

16.  On the Deltek Time And Expense 10.0.0 Admin SQL Server Database Information 
screen, complete the following fields about your Costpoint 7.1.1 Admin schema. 

Field Name Action 

IP Address or 

Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 

example, dbsvr01) of your Costpoint 7.1.1 Admin (CPADMIN) 
database server. The default value is your computer name. 

The value entered in the IP Address or Hostname field cannot be 

127.0.1.0.1 or localhost. 

For RAC installations, you must specify the IP Address or 
Hostname of one of the instances. Do not use the Virtual IP 

Address. 

Port Enter the SQL Server TCP port the Costpoint database server. 

The default port for SQL Server is 1433. 

Currently, this installer will allow database installations to connect 
to a SQL Server DEFAULT instance over port 1433 only. Use of 

non-default ports will be addressed in a future release. 

Database Name Enter the name of your Costpoint database. The default value is 

CPADMIN. Deltek recommends using the same database you 
used for your transaction database (i.e., DELTEKCP). Optionally, 
clients may use a new database name (i.e., CPADMIN). 

Instance Name Enter the name of your Costpoint database instance. The default 
value is LOCAL. 

User Name Enter the name of your Admin user account. The default is 
CPADMIN. The Costpoint Installer creates a SQL Server schema 

with the same name as the user name 

Password Enter the password for your Admin user account. 

SA User Name Enter the name of your Microsoft SQL Server SA user. The default 
is sa. If a user with “sysadmin” privileges is available, that user 

can alternatively be used. 

SA User 

Password 

Enter the password for your Microsoft SQL Server SA user. 

17.  Click Test Connection.  

If you have entered the proper database connection information, a message similar to the 
following is displayed: 

“Connection successful. Click Next.”  

If the message does not display, correct the connection information, and click Test 
Connection again. 

18.  After receiving the message, click Next >. 
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19.  If the Pre-Upgrade Validation Information screen displays, you will NOT be able to 
continue with the upgrade until the validations have been cleared. You will need to note 

the validation issues, Cancel out of this installation, correct the issues, and restart the 
Database Tier Install. 

Here are the two types of validations you may see: 

 PATCHxxx is missing – Apply the Time And Expense 9.0.1 hot fix that contains this 
patch. For Patch274 and 276, this would be HotFix Bundle 8. 

 Un-identified Patch PATCHxxx  – Contact Deltek Customer Care. This database 

patch has not yet been worked into the upgrade to Time And Expense 10.0.0. 

20.  On the Pre-Installation Summary screen, review the installation parameters you selected: 

 If you want to change any settings, click < Back to go back and make the necessary 

changes.  

 If you are satisfied with these settings, click Install > to begin the installation. 

Once initiated, the upgrade process to Time And Expense 10.0.0 will commence. Please 

do not interrupt the process. A Windows Command Prompt will appear on your screen 
that displays the scripts that are being executed. 

The installation will perform the scenarios detailed in the Installation Process for Time 

And Expense 10.0.0 section of this document. The installation process will stop if any 
errors are encountered. If any errors occur during the installation, please refer to the 
Troubleshooting Instructions section of this document. 

21.  On the InstallShield Wizard Complete screen, select the Yes, I want to view the log file 
check box to open the 
DeltekTimeAndExpense1000DatabaseTierInstallLog_<date>_<time>.txt file from the 

C:\Program Files\Deltek\Time And Expense\10.0.0\Logs directory. This check box is 
selected by default. 

22.  Click Finish to exit the installation. 

23.  When the DeltekTimeAndExpense1000DatabaseTierInstallLog_<date>_<time>.txt file 
opens, search for the following keywords: 

 “Error” – Report any search results to Deltek Time And Expense Technical Support. 

You can ignore ""DBCC execution completed. If DBCC printed error messages, 
contact your system administrator." 

 “Database Upgrade To Time And Expense 10.0.0 Completed Successfully” and 

then the line “$DBSUCCESS=TRUE”. 

Finding the last item listed above indicates that you have successfully upgraded your 
select Time And Expense 9.0.1 domain to Time And Expense 10.0.0. 

Make sure that your SQL Server Port, 1433, is open for Inbound and Outbound traffic 
through your firewall. Also, make sure that Network Discovery and File Sharing options 
are switched on. 
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You MUST repeat this exact same process (all 18 items of this Install Database Tier Software 

step) for each of your Time And Expense 9.0.1 remaining domains. That means re-running the 

DeltekTimeAndExpense1000DatabaseTier.exe installer against each schema. 

If your environment currently has three domains, you are required to run the installer three times 

to convert each of the domains separately. During each subsequent run, on the Select Time 

And Expense System screen, you will be presented only with the domains that are not yet 

upgraded. 

Please note it is important to upgrade all your domains within a single database before running 

the SQL Server Collation tool for conversion of database to binary collation. If your business 

requirement requires that you upgrade only certain domain(s), please don’t attempt to convert 

the database collation to binary until all domains are upgraded. Failure to follow this 

instruction will prevent upgrade process to fail for any domains that are not upgraded. 
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Enabling JDBC Distributed Transactions  

Please follow the configuration and setup instructions based on your implementation: 

 If the installer is executed on the database server, all required steps to enable distributed 
transactions were performed during Time And Expense Database Tier installation. This is 

the most common and simple implementation for most clients and can proceed to 
application tier installation. 

 If the installer is executed from an alternative database server or from a cl ient 

connectivity tools desktop with the actual databases residing remotely on a database 
server, please follow the steps documented under “Enable JDBC Distributed 
Transactions and XA for an Instance Using Time And Expense Installer”.  

 If Time And Expense is set up using SQL Cluster configuration, please follow the steps 
documented under “Enable JDBC Distributed Transaction and XA for SQL Cluster 
Configuration”. 

Enable JDBC Distributed Transactions and XA for an Instance 
Using Time And Expense Installer 

1. Create a backup of your Microsoft SQL Server master database. 

2. Copy the DeltekTimeAndExpense1000DatabaseTier.exe installation file to this 
database server where Time And Expense database is created. 

3. Run the DeltekTimeAndExpense1000DatabaseTier.exe /enableXA command to 
launch the Time And Expense Database Tier enable XA program. 

4. On the Microsoft SQL Server for Deltek Time And Expense 10.0.0 Database Information 

screen, complete the following fields: 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Time And Expense 10.0.0 database 
server. The default value is your computer name. 

The value entered in the IP Address or Hostname field cannot 
be 127.0.1.0.1 or localhost. 

For SQL Cluster installations, you must specify the SQL Cluster 

Hostname. 

Port Enter the port that your Time And Expense 10.0.0 database 

server software uses to listen for requests. The default port for 
Microsoft SQL Server is 1433. 

Database Name Accept the default of master. 

Instance Name Enter the name of your Time And Expense 10.0.0 database 

instance used during new install setup. The default value is 
LOCAL.  In addition to standard alphanumeric characters, the 
following special characters are also supported: 

$ - _  
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Field Name Action 

SA User Enter the name of your Microsoft SQL Server SA user. The 
default is sa.  In addition to standard alphanumeric characters, 

the following special characters are also supported: 

$ - _  

Note: If a user with “sysadmin” privileges is available, that user 

can alternatively be used. 

SA Password Enter the password for your Microsoft SQL Server SA user.  In 

addition to standard alphanumeric characters, the following 
special characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

5. Click Test Connection. If you entered the proper database connection information, the 
following message displays: “Connection Successful. Click Next.”  

If this message does not display, correct the information entered and click Test 
Connection again.  

6. After the confirmation message displays, click Next > to begin the installation process. 

The Restarting the Distributed Transaction Coordinator (MSDTC) Service window will 
display as part of the installation process. 

If any errors occur during this step, please call Deltek Technical Support. 

7. Click OK when the following message displays: “Successfully configured XA 
transactions.”  

 

If your Time and Expense 10.0.0 transaction databases reside on different servers, you must 
perform all of the actions in this step against each of the other servers. 
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Enable JDBC Distributed Transaction and XA for Remote 
Database Servers 

If your Costpoint 7.1.1 and Time And Expense 10.0.0 databases reside on different database 
servers, you must perform this step in each of the servers. 

An example for this configuration is shown below: 

 

 

 

 

 

 

 

 

 

 

Based on the configuration above, all steps documented to enable distributed transaction should 

be done on both Server A and Server B. 

To enable distributed transaction and XA for remote database servers, complete  the 
following steps: 

1. Perform this step for the database instance using the instructions on “Enable JDBC 
Distributed Transactions and XA for an Instance Using Time And Expense Installer”. 

2. The sequence of steps to open “Component Services” on your server might be different 

based on your version of Windows OS version. 

3. On the left navigation tree, click Component Services » Computers » My Computer » 
Distributed Transaction Coordinator. 

4. Select Local DTC, right-click, and select Properties. 

5. On Local DTC Properties, select the Security tab. 

a. Select the Network DTC Access check box under Security Settings. 

b. Select the Allow Remote Clients check box under Client and Administration. 

c. Select the  Allow Inbound and Allow Outbound check boxes under Transaction 
Manager Communication. 

d. Select the No Authentication Required option. 

e. Select the  XA Transactions check box. 

6. Click Apply. The following message displays: “The MSDTC Service will be stopped and 

restarted. All dependent services will be stopped. Applications using MSDTC may need 
to be restarted to use the new settings”. Click Yes to proceed. 

7. Click Yes. A message “The MSDTC service has been restarted” should display.  

8. Click OK. 

DBServer A (Instance LOCAL) 

    DELTEKCP (Transaction DB) 

    CPADMIN (Admin DB) 

DBServer B (Instance LOCAL) 

    CPSYSTEM (Meta DB) 

   DELTEKTE (TE Transaction DB) 
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After completing the steps above, your screen selections should look similar to the figure 
shown below: 

 

 

 

For DTC to function correctly, each of the hosts participating should be resolvable by NetBIOS 
name and each remote host should be reachable by name. This function will not work if the host 
server is configured only by IP address (as in many VM test deployments).  In such cases, either 
have your host added to the IP/hostname mappings in your 
“c:\Windows\System32\drivers\etc\hosts” file or if in a domain, add DNS aliases. 

9. If you database server is configured for Windows Firewall, for DTC to function follow the 
necessary firewall settings for MSDTC program. 

a. To open Windows Firewall, click Start » Control Panel. In the search box, enter 

firewall, and click Windows Firewall. 

b. In the left pane, click Allow a program or feature through Windows Firewall . 

c. Click Change settings. If you're prompted for an administrator password or 

confirmation, enter the password or provide confirmation. 

d. Select the Private and Public check boxes next to Distributed Transaction 
Coordinator, and click OK. 

A sample selection of firewall setting for DTC program is shown below:  
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10.  Reboot the server after completing all of the steps above. 

11.  Repeat steps 1 through 4 for each of the servers. In the sample configuration, these 
steps would be repeated for “DBServer A” and “DBServer B”. 

12.  Proceed to the Application Tier Installation section. 

Enable JDBC Distributed Transaction and XA for SQL Cluster 
Configuration 

If your Time And Expense database resides on SQL Cluster configuration and you want to 
enable JDBC distributed transaction, complete the following steps: 

1. Perform this step on the database cluster instance on each node using the instructions 
on “Enable JDBC Distributed Transactions and XA for an Instance Using Time And 
Expense Installer”. 

2. The sequence of steps to open “Component Services” on your server might be different 
based on your version of Windows OS version. 

3. On the left navigation tree, click Component Services » Computers » My Computer » 

Distributed Transaction Coordinator » Clustered DTCs. 

 

If you do not see the “Clustered DTCs” section, you may need to move the DTC 
Service to this node to make this visible. Please reopen “Component Services” after 
moving the DTC service to this node. While the product may be functional by setting 
these properties on the active node during initial installation, it is important that all these 
steps are done in all nodes so that when the SQL Cluster services failover to alternate 
available nodes, the DTC function performs distributed transactions for proper 
application behavior. 

4. Select your configured Distributed Transaction Coordinator Service Name Ex. 
DELTEKDTC, right-click, and select Properties. 

5. Select the Security tab. 

6. Select the XA Transactions check box. 
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7. Click Apply. The following message displays: “The MSDTC Service will be stopped and 
restarted. All dependent services will be stopped. Applications using MSDTC may need 

to be restarted to use the new settings”. Click Yes to proceed. 

8. Click Yes. A message “The MSDTC service has been restarted” should display.  

9. Reboot the server after performing above steps. 

10.  Repeat for each node participating in the cluster. 

11.  Proceed to the Application Tier Installation section. 
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Application Tier Installation 

The Time And Expense 10.0.0 system uses Oracle’s WebLogic Server 12.1.3 and Costpoint 
7.1.1 for its application server tier. During the Application Tier installation process, you will install 
the Time And Expense 10.0.0 software. 

As previously mentioned in the Pre-Installation Instructions section, the Time And Expense 10.0.0 
WebLogic application server must already contain WebLogic Server 12.1.3 and Costpoint 7.1.1. 

Before You Start 

Make sure that you meet all Application Tier Installation Prerequisites. 

Install Application Tier Software 

This step provides instructions for installing the Deltek Time And Expense 10.0.0 software. 

You must perform this step on the machine that will serve as your Time And Expense 10.0.0 
application server. 

You must have Internet access on the machine where the Time And Expense 10.0.0 installer is 
invoked in order to download the latest DeltekTimeAndExpense1000RequirementsINI.exe file 
automatically. The file contains the latest OS platforms and database versions supported. The file 

is automatically downloaded when you launch the Application Tier installation, assuming that your 
application server has Internet access.  

 

The Deltek product installers contain functionality which enables them to dynamically download 

configuration files and patch rollback scripts when the product installers are executed from the 

Deltek Software Manager server.  To improve security, these connections have been modified to 

require communication over HTTPS. 

If your application server does not have internet access, you will need to perform the steps in the 

Latest Upgrade Files Download section of this document before you run the Deltek 
TimeAndExpense1000ApplicationTier.exe file. 

To install the Application Tier software, complete the following steps: 

1. Run the DeltekTimeAndExpense1000ApplicationTier.exe file to launch the Time And 
Expense 10.0.0 Application Tier installation program. The Welcome to the Time And 
Expense 10 Installer screen displays. 

 

Due to enhanced security in Microsoft Windows Server 2012, it is advised that you use 
the Run as Administrator option when launching installation files, even if you are 
logged in as a user with local administrative rights . To Run as Administrator, right-
click the DeltekTimeAndExpense1000ApplicationTier.exe file in Windows Explorer and 
select Run as Administrator. 

2. Click Next >.  

3. On the License Agreement screen, review the license agreement, select the I accept the 
terms of the license agreement check box, and click Next >.  

4. On the Select Deltek Costpoint 7.1.1 Installation Directory screen, navigate to the 

location where your Costpoint 7.1.1 software is installed. The default directory is 
C:\Deltek (recommended). 

file:///C:/Users/dalewastler/Documents/Installs/TE/DeltekTimeAndExpense1000UpgradeInstallationForOracle.docx%23_Latest_Upgrade_Files
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5. Click Next >. 

6. On the Select Deltek Costpoint System Name screen, select the Costpoint System you 

will be using to connect to Time And Expense 10.0.0. Click Next >. 

7. On the Select Database Platform screen, select Microsoft SQL Server. Click Next >.  

8. On the Deltek Costpoint 7.1.1 System SQL Server Database Information screen, 

complete the following fields: 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Costpoint 7.1.1 SYSTEM 

(CPSYSTEM) database server. The default value is your computer 
name. 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 

For RAC installations, you must specify the IP Address or 
Hostname of one of the instances. Do not use the Virtual IP 
Address. 

Port Enter the port that your Costpoint 7.1.1 SYSTEM database server 
software uses to listen for requests. The default port for SQL 

Server is 1433. 

Database Name Enter the name of Costpoint 7.1.1 SYSTEM database. The default 

value is CPSYSTEM.  In addition to standard alphanumeric 
characters, the following special characters are also supported: 

$ - _  

Instance Name Enter the name of your Costpoint 7.1.1 SYSTEM (CPSYSTEM) 
database instance. The default value is local.  In addition to 

standard alphanumeric characters, the following special 
characters are also supported: 

$ - _  

User Name Enter the name your CPSYSTEM user. The default user is 
CPSYSTEM.  In addition to standard alphanumeric characters, the 

following special characters are also supported: 

$ - _  

Password Enter the password for your CPSYSTEM user.  In addition to 
standard alphanumeric characters, the following special 
characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

SA User Name Enter the name of your Microsoft SQL Server SA user. The default 

is sa.  In addition to standard alphanumeric characters, the 
following special characters are also supported: 

$ - _  
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Field Name Action 

SA User 
Password 

Enter the password for your Microsoft SQL Server SA user.  In 
addition to standard alphanumeric characters, the following special 

characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

9. Click Test Connection. If you entered the proper database connection information, then 
the following message displays: “Connection Successful. Click Next.”  

If it this message does not display, correct the information entered and click Test 

Connection again.  

After the “Connection Successful. Click Next.” message displays, click Next >.  

10.  On the Choose Deltek Time And Expense License File screen, click Browse to navigate 

to the Deltek supplied Time And Expense 10.0.0 LICENSE.ZIP file. Click Next >. 

11.  On the Pre-Installation Summary screen, review the installation parameters you selected: 

 If you want to change any settings, click < Back to go back and make the necessary 

changes.  

 If you are satisfied with these settings, click Install > to begin the installation. 

Once initiated, the installation process can take a long time to complete. Please do not 

interrupt the process. A Windows Command Prompt will also appear on your screen that 
displays the scripts that are being executed. 

The installation will perform the scenarios detailed in the Installation Process Changes for 

Time And Expense 10.0.0 section of this document. The installation process will stop if 
any errors are encountered. If any errors occur during the installation, please refer to the 
Troubleshooting Instructions section of this document. 

12.  If there were any errors, the log file  
DeltekTimeAndExpense1000ApplicationTierInstallLog_<date>_<time>.txt (from the 
C:\Program Files\Deltek\Time And Expense\10.0.0\Logs directory) will open. 

13.  The following message displays: 

 

This is just a reminder that there are other steps in this installation document that still 
need to be performed. Click OK. 

14.  When the installation has completed, the InstallShield Wizard Complete screen displays, 
indicating it “… successfully installed Time And Expense 10.0….”. 
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Perform the following: 

 Yes, I want to restart my computer now  – Select this option to reboot your 

Application Server. This option is selected by default.  

 Click Finish to exit the installation and reboot your Application Server. 

15.  Once your Application Server has rebooted, open the  

DeltekTimeAndExpense1000ApplicationTierInstallLog_<date>_<time>.txt file from 
the C:\Program Files\Deltek\Time And Expense\10.0.0\Logs directory. 

16.  When the DeltekTimeAndExpense1000ApplicationTierInstallLog_<date>_<time>.txt 

file opens, search for the following keyword: 

 “Error” – Report any search results to Deltek Costpoint Technical Support. The 
following error messages can be ignored: 

 OnInstallingFile - Installing: C:\Deltek\Costpoint\71\applications\enterprise\APP-
INF\classes\com\deltek\enterprise\application\te\ad\commonad\importengine\ Imp
ortErrorStatusCodes.class 

 OnInstallingFile - Installing: C:\Deltek\Costpoint\71\applications\enterprise\APP-
INF\classes\com\deltek\enterprise\application\te\commontc\utils\ErrorCodes.clas
s 

Configure Time And Expense 10.0.0 Access 

The steps to configure your Costpoint 7.1.1 system to recognize Time And Expense 10.0.0 are 
detailed in this section. 

You must perform this step on your Costpoint 7.1.1 WebLogic application server.  
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To configure your Costpoint System for Time And Expense 10.0.0, complete the following 
steps: 

1. With your Costpoint 7.1.1 service running, click Start » All Programs » Costpoint 7.1.1 
» Start Costpoint 7.1.1 Config Utility. For Windows Server 2012, right-click Start and 
select Search. Under Costpoint 7.1.1, right-click Start Costpoint 7.1.1 Config Utility, 

and click Run as administrator. 

 

Due to the enhanced security in Windows Server 2012, it is advised that you use the 
Run as Administrator option when launching this command even if the logged in user 
has local administrative rights . 

2. On the Select Your Configuration Options screen, make sure the Product Application 
Configuration check box is selected, and click Next. 

3. The following message displays: 

 

This will be cleared once the changes about to be made are saved. Click OK. 

4. On the Product Configuration Utility screen, perform the following: 

a. Click the Product tab. 

b. On the Displaying System field, select the Costpoint System that you are 
configuring for Time And Expense 10.0.0 (that is, DELTEKCP) from the drop-down 

list. 

c. Click the System tab. 

d. In the Products Installed group box, select the TEESS check box. 

e. In the Settings group box, make sure the Production Mode check box is selected. 



Application Tier Installation 

 

Upgrade Installation Guide for Microsoft SQL Server® 35 

 

 

5. On the Costpoint Configuration Utility screen, select the TEESS tab and perform the 
following: 

Field Name Action 

Database Vendor Select MS SQL Server. 

Host Enter the IP address (for example, 10.2.2.154) or hostname (for 

example, dbsvr01) of your Time And Expense 10.0.0 
TRANSACTION (DELTEKTE) database server. The default value 
is your computer name. 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 

For SQL Server Named Instances you need to enter the 
Host\Named Instance, that is, 10.2.2.154\INSTANCE1. 

For RAC installations, you must specify the IP Address or 
Hostname of one of the instances. Do not use the Virtual IP 
Address. 

Port Enter the port that your Time And Expense 10.0.0 TRANSACTION 
database server software uses to listen for requests. The default 

port for SQL Server is 1433. 

For Named Instance entered with Host above this field will be 
disabled. 

DB Name Enter the name of Time And Expense 10.0.0 TRANSACTION 
database. The default value is DELTEKTE. 
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Field Name Action 

User Enter the name of your Time And Expense 10.0.0 TRANSACTION 
user. The default user is TC_0001. 

Password Enter the password for your TC_0001 user. 

Confirm Password Reenter the password for your TC_0001 user. 

URL Accept the default. 

6. Click Test. The following message displays: 

 

7. Click OK. If you were unable to connect, review the information entered and try again. 

8. On the Costpoint Config Utility screen, click Save. The following message displays: 

 

9. If you have additional Time And Expense 9.0.1 Company Domains that you re-ran the 
DeltekTimeAndExpense1000DatabaseTier.exe installer against in the Database Tier 

section, perform the following: 

a. On the Product Configuration Utility screen, perform the following:  

 Click the Product tab. 

 Under Select SYSTEM, click Add or Clone to create a new Costpoint 
System. 

 

Use Clone if your additional System will be using the same Costpoint 
TRANSACTION, ADMIN, and SYSTEM databases . That way, you do 
not have to reenter all of the database connection information. 

 Enter New System Name  – Enter the name for your additional Time 

And Expense 10.0.0 System (that is, TC_0003). 

 Click OK. 

 Click the System tab. 

 Make sure Production Mode is selected. 
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 Click the Standard Database tab. 

 Enter the following information for your Costpoint Meta Segment: 

Field Name Action 

Database Vendor Select MS SQL Server. 

Host Enter the IP address (for example, 10.2.2.154) or hostname (for 

example, dbsvr01) of your Costpoint 7.1.1 SYSTEM 
(CPSYSTEM) database server. The default value is your computer 
name. 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 

For SQL Server Named Instances you need to enter the 
Host\Named Instance, that is, 10.2.2.154\INSTANCE1. 

For RAC installations, you must specify the IP Address or 
Hostname of one of the instances. Do not use the Virtual IP 
Address. 

Port Enter the port that your Costpoint 7.1.1 SYSTEM database server 
software uses to listen for requests. The default port for SQL 

Server is 1433. 

For Named Instance entered with Host above this field will be 
disabled. 

DB Name Enter the name of Costpoint 7.1.1 SYSTEM database. The default 
value is DELTEKCP. 

User Enter the name of your Costpoint 7.1.1 SYSTEM user. The default 
user is CPSYSTEM. 

Password Enter the password for your CPSYSTEM user. 

Confirm Password Reenter the password for your CPSYSTEM user. 

URL Accept the default. 

 Click Test. The following message displays: 

 

 Click OK. If you were unable to connect, review the information entered 

and try again. 

 Enter the following information for your Costpoint Admin Segment: 
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Field Name Action 

Database Vendor Select MS SQL Server. 

Host Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Costpoint 7.1.1 ADMIN (CPADMIN) 
database server. The default value is your computer name. 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 

For SQL Server Named Instances you need to enter the 
Host\Named Instance, that is, 10.2.2.154\INSTANCE1. 

For RAC installations, you must specify the IP Address or 
Hostname of one of the instances. Do not use the Virtual IP 
Address. 

Port Enter the port that your Costpoint 7.1.1 ADMIN database server 
software uses to listen for requests. The default port for SQL 

Server is 1433. 

For Named Instance entered with Host above this field will be 
disabled. 

DB Name Enter the name of Costpoint 7.1.1 ADMIN database. The default 
value is DELTEKCP. 

User Enter the name of your Costpoint 7.1.1  ADMIN user. The default 
user is CPADMIN. 

Password Enter the password for your CPADMIN user. 

Confirm Password Reenter the password for your CPADMIN user. 

URL Accept the default. 

 Click Test. The following message displays: 

 

 Click OK. If you were unable to connect, review the information entered 

and try again. 

 Enter the following information for your Costpoint Data Segment: 

Field Name Action 

Database Vendor Select MS SQL Server. 
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Field Name Action 

Host Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Costpoint 7.1.1 TRANSACTION 

(DELTEKCP) database server. The default value is your computer 
name. 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 

For SQL Server Named Instances, you need to enter the 
Host\Named Instance, that is, 10.2.2.154\INSTANCE1. 

For RAC installations, you must specify the IP Address or 

Hostname of one of the instances. Do not use the Virtual IP 
Address. 

Port Enter the port that your Costpoint 7.1.1 TRANSACTION database 
server software uses to listen for requests. The default port for 
SQL Server is 1433. 

For Named Instance entered with Host above this field will be 
disabled. 

DB Name Enter the name of Costpoint 7.1.1 TRANSACTION database. The 
default value is DELTEKCP. 

User Enter the name of your Costpoint 7.1.1  TRANSACTION user. The 
default user is DELTEK. 

Password Enter the password for your DELTEK user. 

Confirm Password Reenter the password for your DELTEK user. 

URL Accept the default. 

 Click Test. The following message displays: 

 

 Click OK. If you were unable to connect, review the information entered 
and try again. 

 Enter the following information for your DB Links Information: 

Field Name Action 

Link User Enter a name for your link user for this new system. You should 
create a different link user for each system. The default will be 

your System Name_LNK_USER (that is, TC_000x_LNK_USER). 
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Field Name Action 

Link User 
Password 

Enter the password for your new TC_000x_LNK_USER user. 

Confirm Password Reenter the password for your TC_000x_LNK_USER user. 

Data to Admin 
Link 

Accept the default of TC_000x_DATA_TO_ADMIN_LINK. 

Data to Meta Link Accept the default of TC_000x_DATA_TO_SYS_LINK. 

Admin to Meta 

Link 

Accept the default of TC_000x_ADMIN_TO_SYS_LINK. 

 Click Activate (middle of screen near Add/Clone). The following 

message displays: 

 

 Click OK. 

 Click Save. The following message displays: 

 

 Click OK. 

 Click the System tab. 

 Products Installed – Select the TEESS check box. 

 On the Product Configuration Utility screen, select the TEESS tab and 
perform the following: 

Field Name Action 

Database Vendor Select MS SQL Server. 

Host Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Time And Expense 10.0.0 

TRANSACTION (DELTEKTE) database server. The default value 
is your computer name. 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 
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Field Name Action 

For SQL Server Named Instances you need to enter the 
Host\Named Instance, that is, 10.2.2.154\INSTANCE1. 

For RAC installations, you must specify the IP Address or 
Hostname of one of the instances. Do not use the Virtual IP 
Address. 

Port Enter the port that your Time And Expense 10.0.0 TRANSACTION 
database server software uses to listen for requests. The default 

port for SQL Server is 1433. 

For Named Instance entered with Host above this field will be 
disabled. 

DB Name Enter the name of Time And Expense 10.0.0 TRANSACTION 
database. The default value is DELTEKTE. 

User Enter the name of your Time And Expense 10.0.0 TRANSACTION 
user. The default user is TC_000x. 

Password Enter the password for your TC_000x user. 

Confirm Password Reenter the password for your TC_000x user. 

URL Accept the default. 

 Click Test. The following message displays: 

 

 Click OK. If you were unable to connect, review the information entered 

and try again. 

 Click Save. The following message displays: 

 

 Click OK. 
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You must repeat item 9 of this step for each additional Time And Expense 
Company Domain. You will need to add a new Costpoint System for each of your 
Time And Expense 9.0.1 remaining domains. That means for every schema you re -ran 
the DeltekTimeAndExpense1000DatabaseTier.exe installer against, you will now need 
to set up a Costpoint System. 

10.  Once all Time And Expense 10.0.0 Systems have been added, click Close. 

Run Link-Views 

This step provides instructions for running the Link-Views. Link-Views grant your Costpoint 

database schemas ( DELTEK/CPSYSTEM/CPADMIN) the ability to view specific database 
objects owned by the each of the other Costpoint database schemas. You must perform this step 
on your Costpoint 7.1.1 WebLogic application server. 

To run link views, complete the following steps: 

1. On the Costpoint DB Wizard screen, select Link-View, and click Next.  

2. On the System screen, select your product system name, TC0003, from the drop-down 

list. 

3. Click Next. 

4. On the Enter Passwords screen, complete the following: 

Field Name Action 

DBA User Accept the default value, SA. 

Password Enter your SA/system user password. 

5. Click Next.  

6. On the Create Link-View screen, perform one of the following options: 

 Locate the Log file field, and accept the default value 
(C:\Costpoint\Deltek\71\logs\linkView.log). 

 Click the ellipsis button, and complete the following: 

Field Name Action 

File Name Enter a log file name. 

Files of Type Accept the default of Select LOG file or folder (*.log).  

7. Click Select, and click Run. 

8. Click Yes if the following message displays: “Link User “TC_000x_LNK_USER” does not 

exist on <Server_Name>. Do you want the Database Wizard to create 
“TC_000xLNK_USER” now?” 

9. If the Creation Link User screen displays, complete the following: 

Field Name Action 

User Name Accept the default value, TC_000x_LNK_USER. 
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Field Name Action 

TEMPDB Accept the default value of your Admin schema, CPADMIN. 

Enforce SQL 
Server Password 
Complexity 

Clear this check box. 

10.  Click OK. After the process is complete, the following message displays: “Process 
completed without errors.” 

11.  Click OK, and click Cancel. The Costpoint DBWizard screen displays. 

 

You must repeat this step for each additional Time And Expense Company Domain. 

Reinstall Costpoint 7.1.1 Windows Service 

This step provides instructions for reinstalling the Costpoint 7.1.1 Windows service. 

This step must be performed on your Costpoint 7.1.1 WebLogic application server. 

To reinstall Costpoint 7.1.1 to run as a Windows service, complete the following steps: 

1. Click Start » Administrative Tools » Services. 

2. On the Services window, scroll down the Services list, right-click the Costpoint 7.1.1 
service, and click Stop. 

3. Use Windows Explorer to navigate to the directory where the Costpoint 7.1.1 software 

was installed (C:\Deltek\Costpoint\71\bin).  

4. Right-click InstallCPWebasService.cmd, and select Run as administrator. 

Reconfigure and Start Costpoint 7.1.1 Windows Service 

This step provides instructions for reconfiguring and starting the Costpoint 7.1.1 Windows service. 

 

Reinstalling the Costpoint 7.1.1 Windows service above means you need to reset or reconfigure 
all settings you initially configured with your Costpoint 7.1.1 Windows service . 

This step must be performed on your Costpoint 7.1.1 WebLogic application server. 

To reconfigure Costpoint 7.1.1 Windows service, complete the following steps: 

1. Click Start » Administrative Tools » Services. 

2. On the Services window, scroll down the Services list, right-click the Costpoint 7.1.1 

service, and click Properties on the shortcut menu. 

 

If you do not find the Costpoint 7.1.1 service, it must not have installed properly in the 
previous step. Please go back and try that step again. 



Application Tier Installation 

 

Upgrade Installation Guide for Microsoft SQL Server® 44 

 

3. On the Costpoint 7.1.1 Properties screen, click the Recovery tab, and perform the 
following: 

Option Description 

First failure Change the drop-down selection from Take No Action to 
Restart the Service. 

Second failure Accept the default value, Take No Action. 

Subsequent failures Accept the default value, Take No Action. 

Reset fail count after Change from 0 to 1 days. 

Restart service after Accept the default of 1 minute. 

4. Click Apply. 

5. On the Costpoint 7.1.1 Properties screen, click the Log On tab and complete the 
following: 

Field Name Action 

Account Enter the domain Account (for example,  

domain\useraccountname). 

If using a domain service login account instead of using the "Local 
System Account", select This Account. 

Password Enter the password for the domain Account. 

Confirm Password Reenter your password for the domain Account. 

6. Click Apply. Make sure that the login account for the Costpoint Service is in the local 

Administrators group on the Application Tier server.  

Also, keep in mind that this login account must be given full access permissions for any 
Alternate File locations setup (network shared directories). Alternate file locations are 

used for Costpoint users for uploading and downloading files from within Costpoint.  

7. On the Costpoint 7.1.1 Properties screen, click the General tab, and click Start to start 
the Costpoint 7.1.1 service. 

 

The service will immediately indicate that it has started. However, please note that it 
takes several minutes for the Costpoint 7.1.1 service to fully initialize. 

After you have started the service, wait several minutes before attempting to connect to 
the software. 

If you encounter problems with the Costpoint 7.1.1 service, check the 
C:\Deltek\Costpoint\7.1.1\logs\DEServer.log file and report any errors to Deltek 
Costpoint 7.1.1 Technical Support. 

8. Click OK to close the Costpoint 7.1.1 Properties screen. 

9. Close the Services window. 
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Web Tier Installation 

The steps to integrate your Time And Expense 10.0.0 software with the Microsoft Internet 
Information Server (IIS) is detailed in this section. 

The Microsoft Internet Information Server component is optional. The WebLogic Server software 

includes an integrated Web server component that you can use with the Time And Expense 
10.0.0 software. 

Though the use of the IIS component is optional, Deltek strongly recommends that you install it in 

your production environment. In addition to acting as the proxy, the IIS server is also used to load 
balance the cluster nodes. 

Before You Start 

Make sure that you meet all Web Tier Installation (Microsoft IIS) Prerequisites. 

Install Web Tier Software 

The steps to integrate the Time And Expense 10.0.0 system with Microsoft IIS are detailed in this 
section. 

You must perform this step on a Web server that is using Microsoft Internet Information Server. 

You must have Internet access on the machine where the Time And Expense 10.0.0 installer is 
invoked in order to download the latest DeltekTimeAndExpense1000RequirementsINI.exe file 
automatically. The file contains the latest OS platforms and database versions supported. The file 

is automatically downloaded when you launch the Web Tier installation, assuming that your 
application server has Internet access.  

 

The Deltek product installers contain functionality which enables them to dynamically download 

configuration files and patch rollback scripts when the product installers are executed from the 

Deltek Software Manager server.  To improve security, these connections have been modified to 

require communication over HTTPS. 

If your application server does not have internet access, you will need to perform the steps in the 

Latest Upgrade Files Download section of this document before you run the Deltek 
TimeAndExpense1000WebTier.exe file. 

To install Time And Expense 10.0.0 on your Microsoft IIS Web server, complete the 

following steps: 

1. Run the DeltekTimeAndExpense1000WebTier.exe file to launch the Time And Expense 
10.0.0 Web Tier installation program. The Welcome to the Time And Expense 10 Installer 

screen displays. 

 

Due to enhanced security in Microsoft Windows Server 2012, it is advised that you use 
the Run as Administrator option when launching installation files, even if you are 
logged in as a user with local administrative rights . To Run as Administrator, right-
click the DeltekTimeAndExpense1000WebTier.exe file in Windows Explorer and select 
Run as Administrator. 

2. Click Next >.  

3. On the License Agreement screen, review the license agreement, select I accept the 
terms of the license agreement, and click Next >.  

file:///C:/Users/dalewastler/Documents/Installs/TE/DeltekTimeAndExpense1000UpgradeInstallationForOracle.docx%23_Latest_Upgrade_Files
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4. On the Select Deltek Costpoint 7.1.1 Web Server Directory screen, click Browse to 
navigate to an installation location for the Deltek Costpoint 7.1.1 IIS software.  

The default is C:\Deltek. 

5. Click Next >. 

6. On the Pre-Installation Summary screen, review the installation parameters you selected: 

 If you want to change any settings, click < Back to go back and make the necessary 
changes.  

 If you are satisfied with these settings, click Install > to begin the installation. 

Once initiated, the installation process can take a long time to complete. Please do not 
interrupt the process.  

The installation will perform the scenarios detailed in the Installation Process Changes for 

Time And Expense 10.0.0 section of this document.  

The installation process creates the CPWeb Virtual Directory under the Default Website, 
using the Default App Pool. The process also creates a share of your Time And Expense 

10.0.0 Costpoint directory, C:\Deltek\Costpoint\71\applications. In order for the 
Application Server (WebLogic) to deploy hot fixes and updates, this directory must be 
shared with Co-Owner (Full Control) rights. 

7. On the InstallShield Wizard Complete screen, select the Yes, I want to view the log file  
check box to open the 
DeltekTimeAndExpense1000WebTierInstallLog_<date>_<time>.txt file from the 

C:\Program Files\Deltek\Time And Expense\10.0.0\Logs directory. This check box is 
selected by default. 

8. Click Finish to exit the installation. 

9. When the DeltekTimeAndExpense1000WebTierInstallLog_<date>_<time>.txt file opens, 
search for the following keywords: 

 “Error” – Report any search results to Deltek Time And Expense Technical Support. 
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Time And Expense 10.0.0 Initial Log In 
Configuration 

The steps to configure your browser and verify your Time And Expense 10.0.0 Application Tier 

and Web Tier installations are detailed in this section. To confirm that these servers are 
functioning properly, you will log in to Time And Expense 10.0.0 and preview a report.  

Before You Start 

Make sure that you meet all Time And Expense 10.0.0 Initial Log In Configuration Prerequisites. 

Time And Expense 10.0.0 Printer Configuration 

This step is optional. It provides configuration instructions for your Application Tier WebLogic 

Server to allow you to print Time And Expense 10.0.0 reports. This is useful for asynchronous 
printing from the server, especially for tasks such as printing reports through the Job Server in the 
middle of the night. 

 

Users can print to local printers from the workstations without configuring anything in this step. 

You must perform this step on your Time And Expense 10.0.0 application server. 

To create Windows printer objects on your application server, complete the following 

steps: 

1. Click Start » Printers and Faxes. For Windows Server 2012, right-click Start and select 
Control Panel. Under Hardware, select View devices and printers. 

2. On the Printers and Faxes screen, double-click Add Printer. 
3. Use the Add Printer Wizard to create a Windows printer object that will connect and print 

to a printer on your network. 

On your application server, you can create as many Windows printer objects as needed for your 
organization. After the printer objects are created, your Time And Expense 10.0.0 WebLogic 
application server will make the printer objects available to your users. 

Set Web Browser Internet Options 

The steps to configure the Internet Explorer (IE) browser settings to access the Time And 

Expense 10.0.0 system are detailed in this section. 

This step must be performed on all Windows client workstations that will access your Time And 
Expense 10.0.0 WebLogic application server. 

To configure the browser settings for accessing the Time And Expense 10.0.0 system, 
complete the following steps: 

1. Open your Web browser. From the menu bar, click Tools » Internet Options. 

2. On the Internet Options screen, click the General tab, and click Settings under the 
Browsing history section. 

3. On the Temporary Internet Files and History Settings screen, complete the following:  
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Field Name Action 

Check for newer 
versions of stored 

pages 

Select Automatically. 

Disk space to use Enter at least 100 Megabytes (MB). 

4. Click OK to close the Settings screen. 

5. On the Internet Options screen, click the Security tab, and click Trusted sites » Sites. 

Depending on your environment, you may need to add your Time And Expense 10.0.0 
URL under Local Internet instead of Trusted sites. 

6. On the Add this website to the zone , enter http://<IPAddress or ComputerName>, 

where <IPAddress or ComputerName> identifies your Time And Expense 10.0.0 
WebLogic application server or IIS Web server, depending on which server you will be 
using to access Time And Expense 10.0.0 (for example, http://10.2.2.154). 

7. Clear the Require server verification (https:) for all sites in this zone  check box. 

8. Select the check box, and click Add. And then, click Close. 

9. On the Internet Options screen, click the Advanced tab, scroll down under the Browsing 

section, and clear the Reuse windows for launching shortcuts check box. 

10.  Click OK to close the Internet Options screen. 

11.  From the menu bar, click Tools » Pop-up Blocker » Turn Off Pop-up Block. 

Disable any pop-up blockers or explicitly allow pop-ups for the Time And Expense 10.0.0 
URL, such as http://<IPAddress or ComputerName>, where <IPAddress or 
ComputerName> identifies your Time And Expense 10.0.0 WebLogic application server 

or IIS Web server (for example, http://10.2.2.154). 

12.  Close your Web browser. 

Log In To Time And Expense 10.0.0 

The steps to log in to Time And Expense 10.0.0 are detailed in this section.  

You can perform this step from any Windows client workstation that has TCP/IP access to your 
Time And Expense 10.0.0 WebLogic application server. 

To log in to Time And Expense 10.0.0, complete the following steps: 

1. Open your Web browser, and enter one of the following URLs: 

 http://<AppServerIPAddress or ComputerName>:<Port>  

 http://<WebServerIPAddress or ComputerName>/cpweb 

Where <AppServerIPAddress or ComputerName> identifies your Time And Expense 
10.0.0 WebLogic application server and <Port> identifies the unique port number that 

your Time And Expense 10.0.0 WebLogic application server uses to listen for 
connections. You specified this port value during the Time And Expense 10.0.0 software 
installation. The default is 7009 (for example, http://10.2.2.154:7009). 

Or where <WebServerIPAddress or ComputerName> identifies your Time And Expense 
10.0.0 IIS Web server (for example, http://10.2.2.156/cpweb). 

http://10.2.2.154/
http://10.2.2.154/
http://10.2.2.154:7001/
http://10.2.2.156/cpweb
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2. When the Deltek Costpoint 7 Welcome screen displays, complete the following:  

Field Name Action 

Username Enter CPSUPERUSER. 

Password Enter password. The password is case-sensitive and must be 
entered in lowercase. Passwords that you create for other user 

IDs may be uppercase, lowercase, or mixed. 

System Enter <Your_System_Name>, where <Your_System_Name> 

identifies the system name you assigned to your Time And 
Expense 10.0.0 system during the Application Server Installation. 
Typically, customers use a system name that is identical to their 

Time And Expense 10.0.0 Database name, DELTEKCP. 

SHOW 

ADDITIONAL 
CRITERIA 

Click + to display these additional fields: 

 Application — Accept the blank default value, or enter a 
specific Time And Expense 10.0.0 application (for example, 
COSTPOINT MENU). 

 Company — Enter your company ID (for example, 1). 

 Validation Frequency — Accept the default drop-down 
value, Field. After you successfully logged in to Time And 

Expense 10.0.0, review the online help for a detailed 
explanation of the value you can select for this field. 

Remember log in 
information 

Select this check box to have the system remember your login 
information. This check box is not selected by default. 

3. Click Log In. 

4. Contact Custom Solutions at Deltek if the following message displays: “Warning: The 
custom programs and the database version are not compatible. The custom programs 

may not work properly. Please contact Custom Solutions at Deltek. Do you want to 
continue with the login?” 

5. Click OK and a screen similar to the sample shown below displays: 
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6. From the main menu screen, click Administration » System Administration » System 
Administration Utilities » Rebuild Global Settings. 

 

7. On the Rebuild Global Settings screen, click Default Action. 
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If you click the right side (down arrow) of the Default Action button, you must also 

select Reload Settings. 

8. On the Processing Complete screen, click OK. 

9. Select File » Close Application to close the Rebuild Global Settings screen. Click OK 

on the unsaved changes message. 

10.  From the main menu screen, click Administration » System Administration » Printing 
» Manage System Printers. 
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11.  On the Manage System Printers screen, click New Record (+).  

 

12.  Complete the following fields: 

Field Name Action 

Printer ID Click  to display all printer objects that are available on your 
Application Server. To select the appropriate printer object, click 
the check box to the left of the printer object name and click 

SELECT. 

Printer Name Enter a descriptive name for the printer object. 

13.  Select the Assigned Users/User Groups link located in the lower right corner of the 
System Printers section. 

14.  When the focus switches to the Assigned Users/User Groups section at the bottom half 
of your browser window, click New Record (+), and complete the following fields: 

Field Name Action 

User/User Group 

ID or User/User 
Group Name 

Click  for one of these fields. Select a User/User Group that 

should have access to the printer object you specified above. 

Company Click  and select a Company for this User/User Group. 

15.  Click SELECT. You must repeat step 14 for each User/User Group that you want to 

assign the printer object that you specified in Step 12. 
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16.  Click Save. Click OK when the following message displays: “Record modifications 
completed without error.” 

You must repeat items 12–16 for any printer objects on your Application server that you 
want to make available to your Time And Expense 10.0.0 system users.  

17.  Click File » Log-out to exit Time And Expense 10.0.0.  

18.  Close your Web browser. 

Verify Time And Expense 10.0.0 Printer Configuration 

The steps to verify your Time And Expense 10.0.0 printers are detailed in this section. 

This step can be performed from any Windows client workstation that has TCP/IP access to your 
Time And Expense 10.0.0 WebLogic application server. 

To verify your Time And Expense 10.0.0 printers, complete the following steps: 

1. Open your Web browser, and enter one of the following URLs: 

 http://<AppServerIPAddress or ComputerName>:<Port>  

 http://<WebServerIPAddress or ComputerName>/cpweb 

Where <AppServerIPAddress or ComputerName> identifies your Time And Expense 
10.0.0 WebLogic application server and <Port> identifies the unique port number that 
your Time And Expense 10.0.0 WebLogic application server uses to listen for 

connections. You specified this port value during the Time And Expense 10.0.0 software 
installation. The default is 7009 (for example, http://10.2.2.154:7009). 

Or where <WebServerIPAddress or ComputerName> identifies your Time And Expense 

10.0.0 IIS Web server (for example, http://10.2.2.156/cpweb). 

2. On the Deltek Costpoint 7 Welcome screen, complete the following fields:  

Field Name Action 

Username Enter CPSUPERUSER. 

Password Enter the CPSUPERUSER user password. The default is 
password. 

System Enter <Your_System_Name>, where <Your_System_Name> 
identifies the system name you assigned to your Time And 

Expense 10.0.0 system during the Application Server Installation 
process. Typically, customers use a system name that is identical 
to their Time And Expense 10.0.0 Database name, DELTEKCP. 

SHOW 
ADDITIONAL 

CRITERIA 

Click + to display these additional fields: 

 Application — Accept the blank default value, or enter a 

specific Time And Expense 10.0.0 application (for example, 
COSTPOINT MENU). 

 Company — Enter your company ID (for example, 1). 

 Validation Frequency — Accept the default drop-down 
value, Field. After you successfully logged in to Time And 

http://10.2.2.154:7001/
http://10.2.2.156/cpweb
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Field Name Action 

Expense 10.0.0, review the online help for a detailed 
explanation of the value you can select for this field. 

Remember log in 
information 

Select this check box to have the system remember your login 
information. This option is not selected by default.  

3. Click Log In.  

4. Click OK if the following message displays: “Warning: The custom programs and the 

database version are not compatible. The custom programs may not work properly. 
Please contact Custom Solutions at Deltek. Do you want to continue with the login?”  

5. From the main menu screen, click Administration » Security » Security 

Reports/Inquiries » Print User Group Rights Report. 

 

6. On the Print User Group Rights Report screen, click Print Options. 
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7. On the Print Options screen, select the System Printer or the Local Printer Delivery 
Option, depending on how you set up your Application Server printer. Then, click OK. 

8. On the Print User Group Rights Report screen, click Print Default Report. 

 

If the User Group Rights Report prints correctly, then your Time And Expense 10.0.0 
Application Server printer setup is working properly. If the report does not print correctly, 

please contact Deltek Time And Expense 10.0.0 Technical Support.  

9. Click File » Close Application to close the Print User Group Rights Report screen. 
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10.  Click OK when the following message displays: “You have unsaved changes. Select 
Cancel to go back and save changes or select OK to discard changes and close the 

application”  

11.  You can now begin to configure and use the Time And Expense 10.0.0 system. Please 
refer to the Related Documentation section for a list of all documentation included with 

the Time And Expense 10.0.0 release. 
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Collation Conversion 

 

If you plan to support European language character set specifically with Euro symbol 
as part of any description or text and your current collation is not Latin1_General_BIN, 
you are required to run the conversion tool to support those special 
characters/symbols. 

Before converting your Time and Expense database to binary collation, it is required 
that all domain(s)/schema(s) within the database are upgraded to 10.0.0 prior to 
converting to binary collation.  

This section provides instructions for converting your Time and Expense 10.0.0 
databases/schema(s) from your current collation (for example, 

SQL_Latin1_General_CP1_CI_AS) to Latin1_General_BIN. Deltek now strongly recommends 
converting to the Latin1_General_BIN collation for proper application functionality. 

Starting with Time and Expense 10.0.0, if you use SQL Server RDBMS, you are recommended to 

change the default collation on your Time and Expense database to Latin1_General_BIN. Deltek 
provides the collation utility, which is downloadable from DSM. 

If you are converting your database collation, you must perform the steps in this section for all 

schema(s) of your Time and Expense 10.0.0 databases or schemas on your Time and Expense 
database server(s) or from a Windows client machine with connectivity to the database server. 
Deltek highly recommends that you convert other schemas contained within the Time and 

Expense databases for compatibility reasons as well.  If you are a Costpoint client and have 
performed this conversion on your Costpoint database(s), it is required that your Time and 
Expense database also be converted to binary collation. The only schema that is not required to 

be converted to binary collation is the admin schema, TC_0000, which is no longer used in Time 
and Expense 10.0.0 

 

Please note that the default SQL Server collation setting of SQL_Latin1_General_CP1_CI_AS 
should not be modified at the SQL Server instance level.  Time and Expense requires a non-
binary collation at the instance level for SQL Server installations. 

Background 

Starting with Time and Expense 10.0.0, Deltek strongly encourages clients using a Microsoft SQL 
Server database to validate the database collation currently used. If it does not match the 
recommended collation, run the provided collation conversion tool to switch to the recommended 

collation. 

 

New customers installing Time and Expense 10.0.0 are not affected by this conversion as newly 
installed databases already have the proper collation. 

The text below is intended to provide background and rationale for this change as well as what 

impact the decision to convert or stay with the current collation will have on your enterprise.  

Time and Expense utilizes data filtering and sorting in performing many financial calculations and 
reporting. Depending on the situation, the filtering and sorting may be performed at any tier in the 

product—database, application server, or client browser/application. It is important that all tiers 
within the product perform data filtering and sorting the same way to have a guaranteed and 
predictable result. Upon evaluating various third-party products and technologies, which comprise 

the Time and Expense technology stack, we found that all products (with the exception of 
Microsoft SQL Server) by default perform data comparison and sorting operations in the same 
way, treating data as case-sensitive. Microsoft SQL Server is the only third-party product which 
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by default treats data as case-insensitive. At the same time, SQL Server allows the database 
administrator to choose comparison and sorting rules by selecting the appropriate collation. 

The Microsoft SQL Server collation supported with Time and Expense is “Latin1_General_BIN”, 
which makes the SQL Server database compare and sort data in the same way that Java, 
JavaScript, and Oracle database do. As part of the upgrade to Time and Expense 10.0.0, Deltek 

is providing a Collation Conversion Tool for customers that use Microsoft SQL Server. For 
existing Time and Expense upgrades, the Collation Conversion tool will need to be run after the 
upgrade has been successfully completed for all domains to bring the Time and Expense 

database to the above supported collation. This is only for databases that are not currently using 
our recommended collation. 

The Collation Conversion Tool will set the collation of your Microsoft SQL Server Time and 

Expense database to “Latin1_General_BIN”. This setting is binary case sensitive, and may have 
an impact on customer specific programs, reports, data imports, and other applications which 
interact with Time and Expense and/or the underlying Time and Expense database. These 

applications and programs may need to be modified and need to be re-tested as part of your 
Time and Expense 10.0.0 upgrade. 

For example: 

 If custom scripts or stored procedures exist where the table and field names are in lower or 
mixed case, the scripts and stored procedures will need to be modified so that they match the 
object case-sensitivity which is always uppercase for Time and Expense tables.  

 If end -ser queries refer to account names in lower case, and the account names are actually 
in mixed case or uppercase, the queries will need to be adjusted so that they use the same 
case as the account names. 

 If reports or data import programs interact with Costpoint, they may need to be adjusted and 
re-tested as well. 

We recognize that this can be a significant change for some customers during the Time and 

Expense upgrade. For additional assistance in evaluating this collation change, and its impact on 
your existing applications and programs, please contact Deltek Services. For a more detailed 
explanation of collation, please refer to the Microsoft online help.  

If evaluation of the collation impact is not feasible in the timeframe defined for your Time and 
Expense 10.0.0 transition, it's possible to run the collation conversion tool after the upgrade is 
already done at a later point 

Deltek will continue to provide support for clients who use a different collation, unless Deltek has 
reason to believe that the reported issue is caused by the unsupported collation. Customers 
should weigh the level of effort associated with modifying and testing of internally developed 

programs interfacing with Time and Expense against the risk associated with staying on their 
existing collation settings. 

Deltek provides a Collation Conversion tool to help you make the switch to the new collation 

setting. The tool can be used to change the collation on any schema within a database. This tool 
converts the collation setting on the database as well as for objects owned by one schema. In 
order to convert more than one schema within the same database, re-run this tool multiple times 

against each schema that is an active domain of the Time and Expense system. 

The Collation Conversion tool uses the SQL DMO objects for which the SQL Server 2005 
Backward Compatibility Feature Pack must be installed before starting the conversion 

The entire collation conversion is split into multiple stages, and restart capability is provided from 
the point of failure. You must correct the problem before re-executing the Collation Conversion 
tool from the point of failure. 
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If you are converting your database collation, you must repeat the steps in this section for each 
of your Time and Expense 10.0.0 databases and/or schemas. 

Prerequisites 

Before you begin, the following prerequisites should be met: 

 Database Server(s) must have SQL Server 2005 Backward Compatibility Feature Pack 
installed even if you current instance of SQL Server version is at the latest release of SQL 

2012 or SQL 2014. 

 SQLServer2005_BC_x64.msi — For 64-bit installations 

 SQLServer2005_BC.msi — For 32-bit installations 

 

You can download this feature pack from Microsoft using the following link: 
http://www.microsoft.com/en-us/download/details.aspx?id=15748. 

 Microsoft .NET Framework 3.5 or 3.5 SP1 (3.5.1) and 1 GB free space to run the install. 

 Make a full backup of the database(s) containing all your Time and Expense domain(s) 

(schema(s)). 

 Make sure your Transaction schema name is in all uppercase. If not, please confirm with your 
internal DBA to convert schema and user names to uppercase before starting the collation 

conversion. 

 Make sure all Time and Expense services and open database connections are closed before 
starting the collation conversion process. 

 Stop the Time and Expense 10.0.0 WebLogic Server. 

 If using full recovery option on the database level, please set your transaction log backup to 
every 15 minutes to maximize log file usage during the conversion process period. Even if 

simple recovery option is selected, the log file can grow larger based on the table size and 
the number of records within a table. Please make sure enough disk space is available in the 
drive where the database log file is located to prevent unexpected behavior.  

Collation Conversion 

Purpose 

This section provides instructions on how to perform the actual Collation Conversion on your 
Time and Expense 10.0.0 Microsoft SQL Server database. 

To convert your Time and Expense database, complete the following steps: 

1. From your Time and Expense 10.0.0 Application server, s top the Time and Expense 
10.0.0 WebLogic Server if it is running. 

 

Please refer to “Appendix G: Starting/Stopping Time and Expense 10.0.0 WebLogic 
Server" for instructions on stopping the Time and Expense 10.0.0 WebLogic Server. 

2. Make a full backup of the database(s) containing the Time and Expense schemas before 
converting. 

http://www.microsoft.com/en-us/download/details.aspx?id=15748
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You must have a good backup of all Time and Expense databases and schemas 
before proceeding with the conversion. 

3. Install the SQL Server 2005 Backward Compatibility Feature Pack as instructed in the 

prerequisites above. 

 

The backward compatibility feature must be installed on the database server where the 
collation conversion is desired. 

4. Make sure all Time and Expense services and open database connections are closed 

before starting the collation conversion process. 

5. Locate and run DeltekCostpoint711Collation.exe to launch the Collation conversion 
program. The Welcome to the Deltek Costpoint Collation Conversion Wizard screen 

displays. 

 

Due to enhanced security in Windows Server 2012, it is advised to use the option to 
Run as Administrator when launching the installation executables even when the 
logged in user has local administrative rights . This option is accessed by right-clicking 
the installation executable file name in Windows Explorer, and selecting Run as 
Administrator to launch the program. 

6. Click Next >. The License Agreement screen displays. 

7. Review the license agreement, and select the I accept the terms of the license 
agreement option. 

8. Click Next >. The Choose Database Collation Scripts Directory screen displays. 

9. Click Browse to navigate to an installation location for the Time and Expense Collation 
script files. The default is C:\Program Files\Deltek\Costpoint\. You will need to install to 

a different location for each of your schema conversions. Deltek recommends appending 
the name of each of your schemas to the default location, for example: 

 C:\Program Files\Deltek\Costpoint\TC_0005 

 C:\Program Files\Deltek\Costpoint\TC_0009 

10.  Click Next >. The Microsoft SQL Server Database Information screen displays.  

11.  Perform the following: 

 IP Address or Hostname — Enter the IP address (for example, 10.2.2.154) or 
hostname (for example, dbsvr01) of your Time and Expense 10.0.0 database server. 
The default is your computer name. 

 

The IP Address or Hostname cannot be 127.0.0.1 or localhost. 

 Port — Enter the port that your Time and Expense 10.0.0 Transaction database 
server software uses to listen for requests. The default port for Microsoft SQL Server 

is 1433. 

 Database Name — Enter the name of your Time and Expense 10.0.0 Transaction 
(Ex. DELTEKTE) database. 

 Instance Name — Enter the name of your corresponding Time and Expense 10.0.0 
database instance. The default is LOCAL. 
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 User Name — Enter the user (for example, TC_0005) for your corresponding Time 
and Expense 10.0.0 database. 

 Password — Enter the password for your corresponding Time and Expense 10.0.0 
database user. 

 Schema Name — Enter the schema name (TC_0005) for your corresponding Time 

and Expense 10.0.0 database. 

 

The schema name is case-sensitive. 

 SA User Name — Enter the name of your Microsoft SQL Server SA user. The 

default is sa. 

 SA User Password — Enter the password for your Microsoft SQL Server SA user. 

12.  Click Test Connection. If you entered the proper link user connection information, the 

“Connection Successful. Click Next.”  message displays. If this does not display, 
correct the information entered and click Test Connection again. After the message 
displays, click Next >. The Pre-Installation Summary screen displays. 

13.  Review the installation parameters you selected.  

 If you want to change any settings, click < Back to go back and make the necessary 
changes.  

 If you are satisfied with these settings, click Install >. 

 When the "You are about to perform a collation conversion on your 
<Schema_Name> database schema, please select "Yes" to confirm or "No" to 

cancel." message displays, click Yes to begin the conversion. 

 

Based on your schema data size, this conversion can take a long time to 
complete. Please do not interrupt it. A Windows Command Prompt will also open, 
showing the scripts being executed. 

It will perform the following (stopping if any errors are encountered): 

 Run Collation Conversion 

It is normal for Stage 4 and Stage 6 to run for a longer period of time (in hours based on 

database size). During this time, please don’t kill the process from task manager or 
reboot your server. 

14.  When the conversion has completed, the InstallShield Wizard Complete screen displays, 

indicating it “… has successfully installed the Deltek Time and Expense Collation 
software and converted your database….” 
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Perform the following: 

 Yes, I want to view the log file  — Select this check box to open the 

DeltekCostpointCollationInstallLog_<date>_<time>.txt file (from the 
<COLLATION_INSTALL_DIR>\Database\Scripts\Collation\ directory). It is 
selected by default. 

 Click Finish to exit the installation. 

15.  When the DeltekCostpointCollationInstallLog_<date>_<time>.txt file opens, perform the 
following: 

 Search for “COLLATION CONVERSION COMPLETED” then the line 
“$DBSUCCESS=TRUE”. 

 Above those lines you will also see the following (one DATABASE_NAME per run):  

7-10-2015 16:12:34 (IS)    AppendFileToLogFile - DATABASE_NAME                                                COLLATION_NAME                                     

7-10-2015 16:12:34 (IS)    AppendFileToLogFile - ----------------------------------------------------- ------- ----------------------------------

---------------- 

7-10-2015 16:12:34 (IS)    AppendFileToLogFile - TE10STQC12                                                   Latin1_General_BIN                                 

7-10-2015 16:12:34 (IS)    AppendFileToLogFile -   

7-10-2015 16:12:34 (IS)    AppendFileToLogFile - TABLE_NAME                                                                                                                       

COLUMN_NAME                                                                                                                      

7-10-2015 16:12:34 (IS)    AppendFileToLogFile - ----------------------------------------------------- ---------- --------- --------- --------- -----

--------------------------------- ------------------------------------------------ --------- --------- --------- --------- --------- ---------- --------- --------- ------- 

7-10-2015 16:12:34 (IS)    AppendFileToLogFile -  

7-10-2015 16:12:34 (IS)    AppendFileToLogFile - Fri Jul 10 16:12:27 2015 -- COLLATION CONVERSION COMPLETED  

7-10-2015 16:12:34 (IS)    AppendFileToLogFile - $DBSUCCESS=TRUE 

 

Finding the above proves that you successfully converted your database schema. 

You must repeat this Conversion section for each of your Time and Expense 10.0.0 
database schema(s) or domain(s).  
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Troubleshooting 

This section provides guidance for troubleshooting issues encountered with the Collation 

Conversion tool. 

Failure after Stage 0 — DMO Test 

If you encounter a failure during the Change Collation conversion process, you may see the 
following message in the log file. 

“Stage 0 - DMOTest Failed” 

In order to fix, install the SQL Server 2005 Backward Compatibility Components Feature Pack 
that is included with the distribution. The files can be found in your 
<COLLATION_INSTALL_DIR>\Database\Scripts\Collation\ folder. 

The file names are: 

 SQLServer2005_BC_x64.msi — Use for 64 bit installations 

 SQLServer2005_BC_x86.msi — Use for 32 bit installations 

Stage 7 — Creation Of Foreign Keys 

During the change collation process to Latin1_General_BIN, when recreating foreign keys on the 
Time and Expense tables, it is possible to run into failures in Stage 7. This can happen even 

though the same foreign key constraint existed on the referencing table before the change in 
collation. Failure in any foreign keys will result in a failed status of the conversion program. 

The error message is visible in the log file found in 

<COLLATION_INSTALL_DIR>\Database\Scripts\Collation\Log and the SQL script that failed 
is named <DB_NAME>_<SCHEMA NAME>_CreateScript.sql  and can be found in 
<COLLATION_INSTALL_DIR>\Database\Scripts\Collation\DBCollationScripts. The 

information and location is only provided for informational message and the actual commands 
needed to recreate is contained within the log file. 

One common reason for this failure is the case-sensitivity of the data after the collation change to 

Latin1_General_BIN. If the data in the referencing table is not in the same case as the 
corresponding data in the referenced table, it will result in failure during the creation of foreign 
keys. 

The solution is to update the data in the referencing table to match the case of the corresponding 
data in the referenced table and then restart the Collation Conversion tool. Alternately, you can 
update the Primary Key in the referenced table if more than one child table references this 

Primary Key. 

Towards the verification section in Stage 9, if there are any foreign key failures, all missing 
foreign key will be listed similar to the following along with the commands needed to recreate.  

7-10-2015 16:12:34 (IS)    AppendFileToLogFile - The f ollowing f oreign key s are missing, please correct the necessary  data and rebuild the 
key s f or proper application f unctionality : 

7-10-2015 16:12:34 (IS)    AppendFileToLogFile -   

7-10-2015 16:12:34 (IS)    AppendFileToLogFile - Missing Foreign Key :F21766 

7-10-2015 16:12:34 (IS)    AppendFileToLogFile - ALTER TABLE [TC_0005].[EVENT] ADD CONSTRAINT [F00104] FOREIGN KEY 7-10-

2015 16:12:34 (IS)    AppendFileToLogFile -  ( 

7-10-2015 16:12:34 (IS)    AppendFileToLogFile -   [FUNCTIONAL_ROLE_CD] 

7-10-2015 16:12:34 (IS)    AppendFileToLogFile -  ) REFERENCES [FUNCTIONAL_ROLE] ( 

7-10-2015 16:12:34 (IS)    AppendFileToLogFile -   [FUNCTIONAL_ROLE_CD] 

7-10-2015 16:12:34 (IS)    AppendFileToLogFile -  ) ON DELETE CASCADE  
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7-10-2015 16:12:34 (IS)    AppendFileToLogFile - GO 

For example, in the following scenario, the creation of foreign key constraints F00104 failed 
during the collation conversion process. In order to rectify this issue, find the rows in the 
referencing table (EVENT) that do not match rows in the referenced table (FUNCTIONAL_ROLE) 

and re-run the statement to create the foreign keys. If the issue is due to the case-sensitivity of 
the data, the corresponding rows in the referenced table are updated.  

SELECT FUNCTIONAL_ROLE_CDFROM EVENTA WHERE NOT EXISTS (SELECT * FROM 

FUNCTIONAL_ROLEB WHERE B. FUNCTIONAL_ROLE_CD= A. FUNCTIONAL_ROLE_CD) 

GO 

UPDATE FUNCTIONAL_ROLESET FUNCTIONAL_ROLE_CD= 'PADMIN' WHERE 
FUNCTIONAL_ROLE_CD_ID = ’PAdmin’ 

GO 

ALTER TABLE [TC_0001].[EVENT] ADD CONSTRAINT [F00104] FOREIGN KEY  

 ( 

  [FUNCTIONAL_ROLE_CD] 

 ) REFERENCES [FUNCTIONAL_ROLE] ( 

  [FUNCTIONAL_ROLE_CD] 

 ) ON DELETE CASCADE  

GO 

After successfully creating all the listed failed foreign keys, re-run the conversion tool to confirm 
the final step is completed with a successful message. 

 

Re-running the installer will only verify that all required foreign keys are re-created and no further 
action is necessary. 

If the failure happens due to a composite primary key, please modify the above query to include 
all columns of the composite key so the resulting data set represents the correct results.  

For example, during creation of constraints, if the create script fails midway through the 
execution, re-executing the script may result in other types of errors because some of the 
constraints were created previously. 

 

If you run into errors during collation conversion and are unable to troubleshoot the issue, please 
contact Deltek Technical Support.  

Unable to Connect to Time and Expense 10.0.0 after Collation Conversion 

If you are unable to connect to Time and Expense 10.0.0 after converting the collation on all your 

database schemas, you may need to check the following: 

 Start Costpoint 7.1.1 Config Utility — On the Time and Expense tab, under the Database 
Information tab, you may need to update the User under your Meta Segment and Admin 

Segment sections. The user name case will need to match the case of your schema 
name for all segments.  

 Costpoint 7.1.1 Windows Service  — Stop and Restart your Costpoint 7.1.1Windows 

service. 
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Apply Latest Time And Expense 10.0.0 Hot Fixes 

Updates to Time And Expense 10.0.0 will be released in a Cumulative Update installer. 

Once you have a functioning Time And Expense 10.0.0 environment, follow the 

DeltekTimeAndExpense1000DeployingHotFixes.pdf installation document to install the latest 
Time And Expense 10.0.0 hot fixes. 

Troubleshooting Instructions 

Troubleshooting instructions for problems with the Database Tier installation are detailed in this 
section. 

How to Remedy a Database Tier Installation That Failed 

The steps to repair a Time And Expense 10.0.0 Database Tier installation that has failed are 
detailed in this section. 

If you encounter a failure during the Database Tier installation process, complete the 
following steps: 

1. Click OK if, during the Database Tier Installation, you receive the following error 

message: “Failed to create Time And Expense TRANSACTION Database”  

 

2. After the installation has stopped and a failed installation error message displays on the 
InstallShield Wizard Complete screen, select the Yes, I want to view the log file  check 

box. This opens the 
DeltekTimeAndExpense1000DatabaseTierInstallLog_<date>_<time>.txt file from the 
C:\Program Files\Deltek\Time And Expense\10.0.0\logs directory).  

3. Click Finish to exit the installation. 

4. When the DeltekTimeAndExpense1000DatabaseTierInstallLog_<date>_<time>.txt file 
opens, run a search for the “error” search string. Report all errors found to Deltek Time 

And Expense Technical Support. 

Under error conditions on new installs, the installer does not provide an option to restart. 
One of several actions might be required. 

5. After performing the required actions from Technical Support,  perform the following: 

 Proceed to the Database Tier Installation section at the beginning of this document 
and restart this installation at the Install Database Tier Software  step. 
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 You have the option of continuing to upgrade the failed domain by providing the 
same set of parameters or skip the failed domain and upgrade other domains that are 

yet to be upgraded. 

Latest Upgrade Files Download Instructions 

The Time And Expense Database Tier installer provides certain command-line options that can 

be invoked in special circumstances. To display the currently supported switches:  

 Open Command Prompt in Administrator Mode 

 Navigate to the directory where the installer is located 

 Type DeltekTimeAndExpense1000DatabaseTier.exe /? 

The instructions to download the latest Time And Expense 10.0.0 Database upgrade and 
DeltekTimeAndExpense1000Requirements INI files are detailed in this section. Each installer will 
automatically download the applicable files if your servers have internet access. If your servers do 

not, you will need to run this step for each installer.  

You must perform this step on any machine that has Internet access.  

To download the required upgrade files, complete the following steps: 

1. Run the applicable command to retrieve the files from DSM: 

DeltekTimeAndExpense1000DatabaseTier.exe /filedynamicdownload 

DeltekTimeAndExpense1000ApplicationTier.exe /filedynamicdownload 

DeltekTimeAndExpense1000WebTier.exe /filedynamicdownload 

You will see the following screen. 

  

2. After the file downloads a message similar to the following displays, click OK. 
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3. Copy the downloaded DeltekTimeAndExpense1000DatabaseUpgradeFiles.exe / 
DeltekTimeAndExpense1000RequirementsINI.exe  file(s) to your server, in the same 

folder as your ‘.exe’ installer file.  

 



 

 

 

Deltek is the leading global provider of enterprise software and information solutions for professional 

services firms, government contractors, and government agencies. For decades, we have delivered 
actionable insight that empowers our customers to unlock their business potential. Over 14,000 
organizations and 1.8 million users in approximately 80 countries around the world rely on Deltek to 

research and identify opportunities, win new business, optimize resource, streamline operations, and deliver 
more profitable projects. Deltek – Know more. Do more.®  

deltek.com 

http://www.deltek.com/
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